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Operating Instructions Administrator Reference

Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.
To get maximum versatility from this machine all operators are requested to read this manual carefully
and follow the instructions. Please keep this manual in a handy place near the machine.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be
liable for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Software Version Conventions Used in This Manual

• NetWare 3.x means NetWare 3.12 and 3.2.

• NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Macintosh, Mac OS, Apple, AppleTalk, EtherTalk, LaserWriter, Rendezvous are registered trademarks
of Apple Computer, Inc.

Microsoft, Windows, Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Netscape, Netscape Navigator are registered trademarks of Netscape Communications Corporation.

Novell, NetWare, NDS are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

PCL is a registered trademark of Hewlett-Packard Company.

Solaris is a trademark or registered trademark of Sun Microsystems, Inc. in the United States and other
countries.
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Bluetooth is a Trademark of the Bluetooth SIG, Inc. (Special Interest Group) and licensed to RICOH
Company Limited.

The Bluetooth Trademarks are owned by Bluetooth SIG, Inc. USA

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows 95.

• The product name of Windows® 98 is Microsoft® Windows 98.

• The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

• The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

• The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

• The product names of Windows ServerTM 2003 are as follows:
Microsoft® Windows ServerTM 2003 Standard Edition
Microsoft® Windows ServerTM 2003 Enterprise Edition
Microsoft® Windows ServerTM 2003 Web Edition

• The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

• Microsoft® Windows NT® Workstation 4.0

 Notes:

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.
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How to Read This Manual

Symbols

In this manual, the following symbols are used:

R WARNING:

This symbol indicates a potentially hazardous situation which, if instructions are not followed, could
result in death or serious injury.

R CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions are not followed, may re-
sult in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

Important

If this instruction is not followed, paper might be misfed, or data might be lost. Be sure to read this.

Preparation

This symbol indicates the prior knowledge or preparations required before operating.

Note

This symbol indicates precautions for operation, or actions to take after misoperation.

Limitation

This symbol indicates numerical limits, functions that cannot be used together, or conditions in which
a particular function cannot be used.

Reference

This symbol indicates a reference.
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[ ]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.

{ }
Keys built into the machine's control panel.

Keys on the computer's keyboard.
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Confirming a Network Environment

NetWare (Server)

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
(Server)

Macintosh

         NetWare
          (Client)

UNIX

Windows 95/98/Me/
2000/XP

Windows Server 2003

Windows NT 4.0

ACT001S
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❖❖❖❖ Connecting Printer and Computer

• Network connection (Ethernet cable, IEEE 1394 cable (IP over 1394), IEEE 802.11b (wireless
LAN))

• Parallel connection (parallel cable)

• USB connection (USB cable)

• IEEE 1394 (SCSI print) connection (IEEE 1394 cable)

• BluetoothTM connection
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Print Server Configuration

You can use Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 as a Print Server.

See p.14 “Windows 2000 Print Server Configuration”.

See p.35 “Windows XP, Windows Server 2003 Print Server Configuration”.

See p.54 “Windows NT 4.0 Print Server Configuration”.

Netware Configuration

To set the machine up as a network printer in a NetWare environment. The network interface board
allows you to use the machine as a print server or remote printer.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
Print Server

Windows 95/98/Me/
2000/XP

Windows Server 2003 Windows NT 4.0

ACT002S

Print Server
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See p.75 “NetWare Configuration”.

NetWare
File Server

Print Server

Windows 95/98/Me/
2000/XP

Windows NT 4.0Windows Server 2003

ACT003S

NetWare
Print Server

NetWare
File Server

Remote Printer

Windows 95/98/Me/
2000/XP

Windows Server 2003 Windows NT 4.0

ACT004S
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1. Windows 2000 Print Server Configuration

To use a network printer, click [SmartDeviceMonitor], [Standard TCP/IP Port], or [LPR Port] when in-
stalling the printer driver.

• SmartDeviceMonitor
See p.14 “Configuring the Protocols” and p.18 “Installing Software” and p.19 “Installing the PCL
5c or RPCS Printer Driver” or p.24 “Installing the PostScript Printer Driver”.

• Standard TCP/IP Port, LPR Port
See p.14 “Configuring the Protocols” and p.19 “Installing the PCL 5c or RPCS Printer Driver” or
p.24 “Installing the PostScript Printer Driver”.

Note

❒ If you want to use LPR Port, Print Services for UNIX must be installed. For details, see Windows

2000 Help.

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Windows 2000 to use the
TCP/IP protocol and IPP.

Preparation

To use NetBEUI, use the SmartDeviceMonitor for Client port.

Configuring the printer

Configure the printer to use TCP/IP.

• Check TCP/IP is set to active. (The factory default is active.)

• Assign an IP address and make other settings required for TCP/IP .
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Reference

For more information about how to make the above settings, see “Windows 2000 Configuration”,

Client Reference.

If DHCP is used to assign IP addresses, see p.240 “Using DHCP”.

Note

❒ After setting the IP address, use the ping command to confirm that it has been set correctly.

A On the [Start] menu, point to [Programs], point to [Accessories], and then click [Command Prompt].

B Enter the following: (Example: IP address is 192.168.15.16)

C:> ping 192.168.15.16
If the address has been configured correctly, the following message appears.

Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address has been configured incorrectly, the following message appears.

Request timed out.
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Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use TCP/IP.

AAAA On the [Start] menu, point to [Settings], and then click [Network and Dial-up Connections].

BBBB Click [Local Area Connection]. On the [File] menu, click [Properties].

CCCC Check [Internet Protocol (TCP/IP)] is selected in the [Components checked are used by this connec-

tion:] box on the [General] tab.

Note

❒ If the check box for TCP/IP is not selected, select it.

❒ If TCP/IP is not installed, click [Install] on the [General] tab and install it. For more information

about installing TCP/IP, see Windows 2000 Help.

DDDD Configure TCP/IP with an appropriate IP address, subnet mask, and other settings.

Check with the network administrator that the settings are correct.
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Configuring NetBEUI for Printing

This describes how to configure the network interface board and Windows 2000 to use NetBEUI.

Configuring the printer

Configure the printer to use NetBEUI.

• Check NetBEUI is set to active. (The factory default is active.)

Reference

For more information about how to make the above settings, see “Windows 2000 Configuration”,

Client Reference.

Configuring a Windows 2000 computer

Follow the procedure below to configure a Windows 2000 computer to use NetBEUI.

AAAA On the [Start] menu, point to [Settings], and then click [Network and Dial-up Connections].

BBBB Click [Local Area Connection]. On the [File] menu, click [Properties].

CCCC Check [NetBEUI Protocol] is selected in the [Components checked are used by this connection:] box

on the [General] tab.

Note

❒ If the check box for NetBEUI is not selected, select it.

❒ If NetBEUI is not installed, click [Install] on the [General] tab and install it. For more information

about installing NetBEUI, see Windows 2000 Help.
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Installing Software

Installing SmartDeviceMonitor for Client

AAAA Quit all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Note

❒ Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.

CCCC Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

DDDD Click [SmartDeviceMonitor for Client/Admin].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [I accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

FFFF Follow the instructions on the screen.

Note

❒ If you are required to restart the computer after the installation of SmartDeviceMonitor for Client,

restart and continue configuration.



Operating Instructions Administrator Reference

19

Installing the PCL 5c or RPCS Printer Driver

AAAA Quit all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.

CCCC Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

DDDD Click [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [I accept the agreement] to agree with the license agreement,
and then click [Next>].
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FFFF Select the printer drivers you want to use when the [Select Program] dialog box appears, and

then click [Next>].

You can select more than one printer driver.

GGGG Select the [Printer Name] check box to select the printer model(s) you want to use.

To change the printer name, use the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display its settings.

Note

❒ The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-

ing used, model of printer selected, and port being used.

IIII Click [Port], and then click [Add] in the [Change settings for 'Port'] box. 

The [Add Port] dialog box appears.

JJJJ The next part of the procedure depends on the port in use. Follow the section that corresponds

to the port you want to use.

• SmartDeviceMonitor

• Standard TCP/IP Port

• LPR Port

SmartDeviceMonitor

A Click [SmartDeviceMonitor], and then click [OK].

B Select the printer you want to use.
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❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then enter the printer's IP address or host

name.

❖❖❖❖ NetBEUI

A Click [NetBEUI], and then click [Search].
A list of printers that can be used with NetBEUI appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to a broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then enter the NetBEUI address. Check

the NetBEUI network address is on the configuration page. For more information about

printing the configuration page, see p.134 “Printing a Configuration Page”. NetBEUI ad-

dress appears as “\\RNPxxxx\xxx” on the configuration page. Enter the printer's network

path name in the form of “%%Computer name\Share name”. Do not enter “\\” as head

characters but “%%”.

❒ You cannot print to printers beyond routers.

❖❖❖❖ IPP

A Click [IPP].
The IPP setting dialog box appears.
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B To specify the printer's IP address, enter “http://(printer's-ip-address)/ printer” or “ipp://(print-
er's-ip-address)/printer” in the [Printer URL] field.
(Example: IP address is 192.168.15.16)

http://192.168.15.16/printer
ipp://192.168.15.16/printer

C If necessary, enter the names to distinguish the printer in [IPP Port Name]. Enter a different
name from those of existing port names.
If you do not do this, the address entered in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].

Standard TCP/IP Port

A Click [Standard TCP/IP Port], and then click [OK].

B In the [Add Standard TCP/IP Printer Port Wizard] window, click [Next>].

C In the [Printer Name or IP Address] box, enter the printer name or IP address, and then click [Next>].

D In the [Add Standard TCP/IP Printer Port Wizard] window, click [Finish].

LPR Port

A Click [LPR Port], and then click [OK].

B In the [Name or address of server providing lpd] box, enter the printer's IP address.

C In the [Name of printer or print queue on that server] box, enter “lp”, and then click [OK].
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KKKK Make sure the location for the selected printer is displayed after [Port].

LLLL Double-click [Shared] to display share settings.

MMMM To share the printer, select the [Shared] check box.

NNNN Check the boxes under [Share name] to install the alternative driver for the necessary system.

Note

❒ Select the [Shared] check box to start installation of an alternative driver ([Windows NT 4.0/2000]

and [Windows 95/98/Me] are already selected).

❒ You can add an alternative driver after installation. See p.34 “Setting the Printer Shared”.

OOOO Configure the default printer as necessary.

❖❖❖❖ Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

PPPP Click [Continue] to start printer driver installation.

QQQQ When the [Select Program] dialog box appears, click [Finish].

RRRR When the [Installation completion.] dialog box appears, click [Finish].

SSSS Set up the options.

Note

❒ You must set up the options when bidirectional transmission is disabled. For more information

about bidirectional transmission status, see p.32 “Bidirectional transmission”.

Reference

For more information about option settings, see p.30 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Quit all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.

CCCC Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.



Operating Instructions Administrator Reference

25

EEEE Click [Next>].

FFFF Click [Local printer], and then click [Next>].

GGGG Click [Create a new port:].

HHHH The next part of the procedure depends on the port in use. Follow the section that corresponds

to the port you want to use.

• SmartDeviceMonitor

• Standard TCP/IP Port

• LPR Port

SmartDeviceMonitor

A Click [SmartDeviceMonitor], and then click [Next>].

B Select the printer you want to use.

❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then enter the printer's IP address or host

name.
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❖❖❖❖ NetBEUI

A Click [NetBEUI], and then click [Search].
A list of printers that can be used with NetBEUI appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to a broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then enter the NetBEUI address. Check

the NetBEUI network address is on the configuration page. For more information about

printing the configuration page, see p.134 “Printing a Configuration Page”. NetBEUI ad-

dress appears as “\\RNPxxxx\xxx” on the configuration page. Enter the printer's network

path name in the form of “%%Computer name\Share name”. Do not enter “\\” as head

characters but “%%”.

❒ You cannot print to printers beyond routers.

❖❖❖❖ IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the printer's IP address, enter “http://(printer's-ip-address)/ printer” or “ipp://(print-
er's-ip-address)/printer” in the [Printer URL] field.
(Example: IP address is 192.168.15.16)

http://192.168.15.16/printer
ipp://192.168.15.16/printer

C If necessary, enter the names to distinguish the printer in [IPP Port Name]. Enter a different
name from those of existing port names.
If you do not do this, the address entered in [Printer URL] will be set as the IPP port name.



Operating Instructions Administrator Reference

27

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].

Standard TCP/IP Port

A Click [Standard TCP/IP], and then click [Next>].

B In the [Add Standard TCP/IP Printer Port Wizard] window, click [Next>].

C In the [Printer Name or IP Address] box, enter the printer name or IP address, and then click

[Next>].

D In the [Add Standard TCP/IP Printer Port Wizard] window, click [Finish].

LPR Port

A Click [LPR Port], and then click [Next>].

B In the [Name or address of server providing lpd] box, enter the printer's IP address.

C In the [Name of printer or print queue on that server] box, enter “lp”, and then click [OK].

IIII Confirm to select the name of the printer whose driver you want to install, and then click

[Next>].

JJJJ Change the name of the printer if you want, and then click [Next>].

Configure the default printer as necessary. Select the [Yes] check box to set the printer as the default
printer.
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KKKK Select the [Share as:] check box, and then click [Next>].

To change the printer name, use the [Share as:] box.

LLLL Select whether or not you want to print a test page, and then click [Next>].

MMMM Click [Finish].

Printer driver installation starts.

NNNN Set up the options.

Reference

For more information about option settings, see p.30 “Setting Up Options”.
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Changing Port Settings

This describes how to change SmartDeviceMonitor for Client settings, such as proxy server settings or
IPP URL.

Note

❒ There are no settings for NetBEUI.

AAAA In the [Printers] window, click the icon of the printer you want to use. On the [File] menu, click

[Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration:] dialog box appears.

Note

❒ If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Client

icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each port]

check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

• For IPP, you can configure User Settings, Proxy Settings, and Timeout Settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.
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Setting Up Options

You must set up installed options, paper size, and feed direction with the printer driver when bidirec-
tional transmission is disabled.

Limitation

❒ To change the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission. 

Note

❒ The description uses the PCL 5c printer driver.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Properties].

Note

❒ When you open the printer properties dialog box for the first time after installing the RPCS printer

driver, the confirmation window appears. After that, the initial display of the printer properties di-

alog box appears.

CCCC Click the [Accessories] tab.

Note

❒ If you are using the RPCS printer driver, click the [Change Accessories] tab.

❒ If you are using the PostScript 3 printer driver, click the [Device Settings] tab.
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DDDD Select options you have installed from the [Options] group, and then make any necessary set-

tings.

Note

❒ If you are using the RPCS printer driver, select the options from [Select printer options:].

❒ If you are using the PostScript 3 printer driver, select the options from [Installable Options].

EEEE Click [OK].
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----Bidirectional transmission

When bidirectional transmission is enabled, information about paper size and feed direction settings
is automatically sent to the printer by a computer. You can also check the printer status from your
computer.

• Bidirectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003,
and Windows NT 4.0.

• If you use the RPCS printer driver and bidirectional transmission is enabled, the [Change Accesso-

ries] tab is shaded, and cannot be modified

Note

❒ The RPCS printer driver supports bidirectional transmission and updates the printer status automat-

ically.

❒ The PCL 5c printer driver supports bidirectional transmission; you can update the printer status

manually. However, it does not support bidirectional transmission over a parallel connection.

❒ The PostScript 3 printer driver does not support bidirectional transmission.

Bidirectional transmission requires the following conditions:

❖❖❖❖ When connecting via parallel cable

• The computer must support bidirectional transmission.

• The printer must be set to bidirectional transmission.

• The interface cable must support bidirectional transmission.

• The machine must be connected to the computer using standard parallel cable and parallel con-
nector.

• Under Windows 2000, [Enable bidirectional support] must be selected and [Enable printer pool-
ing] must not be selected on the [port] tab with RPCS printer driver.
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❖❖❖❖ When connecting with the network

• The printer must be set to bidirectional transmission.

• SmartDeviceMonitor for Client included on the CD-ROM must be installed, and TCP/IP must
be used.

• Under Windows 2000, [Enable bidirectional support] must be selected and [Enable printer pool-
ing] must not be selected on the [port] tab with RPCS printer driver.
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Setting the Printer Shared

Limitation

❒ Changing the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Properties].

CCCC Select the [Shared as:] check box on the [Sharing] tab.

DDDD To share a printer with users running different versions of Windows, click [Additional Driv-
ers...], and then follow the instruction on the screen.

Note

❒ If you have installed an alternative driver by selecting the [Shared] check box, you do not have to

follow this step.

EEEE Click [OK].
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2. Windows XP, Windows Server 2003 Print Server Configuration

To use a printer connected to the Ethernet interface, click [SmartDeviceMonitor], [Standard TCP/IP Port],
or [LPR Port] when installing the printer driver.

• SmartDeviceMonitor
See p.35 “Configuring the Protocols”, p.38 “Installing Software”, p.39 “Installing the PCL 5c or
RPCS Printer Driver”, and p.44 “Installing the PostScript Printer Driver”.

• Standard TCP/IP Port, LPR Port
See p.35 “Configuring the Protocols”, p.39 “Installing the PCL 5c or RPCS Printer Driver”, and
p.44 “Installing the PostScript Printer Driver”.

Note

❒ If you want to use “LPR Port”, “Print Services for UNIX” must be installed. For details, see Win-

dows XP or Windows Server 2003 Help.

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

This describes how to configure the network interface board and Windows XP or Windows Server 2003
to use TCP/IP and IPP.

Configuring the printer

Configure the printer to use TCP/IP.

• Check TCP/IP is set to active. (The factory default is active.)

• Assign an IP address and make other settings required for TCP/IP.
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Reference

For more information about how to make the above settings, see “Windows XP, Windows Server

2003 Configuration”, Client Reference.

If DHCP is used to assign IP addresses, see p.240 “Using DHCP”.

Note

❒ After setting the IP address, use the ping command to confirm that it has been set correctly.

A On the [Start] menu, point to [All Programs], point to [Accessories], and then click [Command

Prompt].

B Enter the following: (Example: IP address is 192.168.15.16)

C:> ping 192.168.15.16
If the address is configured correctly, the following message appears:

Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address is configured incorrectly, the following message appears:

Request timed out.
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Configuring a Windows XP or Windows Server 2003 computer

Follow the procedure below to configure a Windows XP or Windows Server 2003 computer to use
TCP/IP.

AAAA On the [Start] menu, point to [Control Panel], and then click [Network Connections].

BBBB Click [Local Area Connection]. On the [File] menu, click [Properties].

CCCC Check [Internet Protocol (TCP/IP)] is selected in the [This connection uses the following items:] box

on the [General] tab.

Note

❒ If the check box for TCP/IP is not selected, select it.

❒ If TCP/IP is not installed, click [Install] on the [General] tab and install it. For more information

about installing TCP/IP, see Windows XP or Windows Server 2003 Help.

DDDD Configure TCP/IP with an appropriate IP address, subnet mask, and other settings.

Check with the network administrator that the settings are correct.
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Installing Software

Installing SmartDeviceMonitor for Client

AAAA Quit all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Note

❒ Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.

CCCC Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

DDDD Click [SmartDeviceMonitor for Client/Admin].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [I accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

FFFF Follow the instructions on the screen.

Note

❒ If you are required to restart the computer after the installation of SmartDeviceMonitor for Client,

restart and continue configuration.
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Installing the PCL 5c or RPCS Printer Driver

AAAA Quit all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.

CCCC Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

DDDD Click [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [I accept the agreement.] to agree with the license agree-
ment, and then click [Next>].
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FFFF Select the printer drivers you want to use when the [Select Program] dialog appears, and then

click [Next>].

You can select more than one printer driver.

GGGG Select the [Printer Name] check box to select the printer model(s) you want to use.

To change the printer name, use the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display its settings.

Note

❒ The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-

ing used, model of printer selected, and port being used.

IIII Click [Port], and then click [Add] in the [Change settings for 'Port'] box.

JJJJ The next part of the procedure depends on the port in use. Follow the section that corresponds

to the port you want to use.

• SmartDeviceMonitor

• Standard TCP/IP Port

• LPR Port

SmartDeviceMonitor

A Click [SmartDeviceMonitor], and then click [OK].

B Select the printer you want to use.
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❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then enter the printer's IP address or host

name.

❖❖❖❖ IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the printer's IP address, enter “http://(printer's-ip-address)/ printer” or “ipp://(print-
er's-ip-address)/printer” in the [Printer URL] field.
(Example: IP address is 192.168.15.16)

http://192.168.15.16/printer
ipp://192.168.15.16/printer

C If necessary, enter the names to distinguish the printer in [IPP Port Name]. Enter a different
name from those of existing port names.
If you do not do this, the address entered in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].
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Standard TCP/IP Port

A Click [Standard TCP/IP], and then click [OK].

B In the [Add Standard TCP/IP Printer Port Wizard] window, click [Next>].

C In the [Printer Name or IP Address] box, enter the printer name or IP address, and then click

[Next>].

D In the [Add Standard TCP/IP Printer Port Wizard] window, click [Finish].

LPR Port

A Click [LPR Port], and then click [OK].

B In the [Name or address of server providing lpd] box, enter the printer's IP address.

C In the [Name of printer or print queue on that server] box, enter “lp”, and then click [OK].

KKKK Make sure the location for the selected printer is displayed after [Port].

LLLL Double-click [Shared] to display share settings.

MMMM To share the printer, select the [Shared] check box.

NNNN Check the boxes under [Share name] to install the alternative driver for the necessary system.

Note

❒ Select the [Shared] check box to start installation of an alternative driver ([Windows NT 4.0/2000]

and [Windows 95/98/Me] are already selected).

❒ You can add an alternative driver after installation. See p.53 “Setting the Printer Shared”.
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OOOO Configure the default printer as necessary.

❖❖❖❖ Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

PPPP Click [Continue] to start printer driver installation.

Note

❒ During installation, the [Software Installation] dialog box may appear. In this case, click [Continue

Anyway] to continue the installation.

QQQQ When the [Select Program] dialog box appears, click [Finish].

RRRR When the [Installation completion.] dialog box appears, click [Finish].

SSSS Set up the options.

Note

❒ You must set up the options when bidirectional transmission is disabled. For more information

about bidirectional transmission status, see p.51 “Bidirectional transmission”.

Reference

For more information about option settings, see p.49 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Quit all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.

CCCC Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.
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EEEE Click [Next>].

FFFF Click [Local printer attached to this computer], and then click [Next>].

GGGG Click [Create a new port:].

HHHH The next part of the procedure depends on the port in use. Follow the section that corresponds

to the port you want to use.

• SmartDeviceMonitor

• Standard TCP/IP Port

• LPR Port

SmartDeviceMonitor

A Click [SmartDeviceMonitor], and then click [Next>].

B Select the printer you want to use.

❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then enter the printer's IP address or host

name.
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❖❖❖❖ IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the printer's IP address, enter “http://(printer's-ip-address)/ printer” or “ipp://(print-
er's-ip-address)/printer” in the [Printer URL] field.
(Example: IP address is 192.168.15.16)

http://192.168.15.16/printer
ipp://192.168.15.16/printer

C If necessary, enter the names to distinguish the printer in [IPP Port Name]. Enter a different
name from those of existing port names.
If you do not do this, the address entered in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].

Standard TCP/IP Port

A Click [Standard TCP/IP], and then click [Next>].

B In the [Add Standard TCP/IP Printer Port Wizard] window, click [Next>].

C In the [Printer Name or IP Address] box, enter the printer name or IP address, and then click

[Next>].

D In the [Add Standard TCP/IP Printer Port Wizard] window, click [Finish].
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LPR Port

A In [Create a new Port:], click [LPR Port], and then click [Next>].

B In the [Name or address of server providing lpd] box, enter the printer's IP address.

C In the [Name of printer or print queue on that server] box, enter “lp”, and then click [OK].

IIII Confirm to select the name of the printer whose driver you want to install, and then click

[Next>].

JJJJ Change the name of the printer if you want, and then click [Next>].

Configure the default printer as necessary. Select the [Yes] check box to set the printer as the default
printer.

KKKK Select the [Share name:] check box, and then click [Next>].

To change the printer name, use the [Share name: ] box.

LLLL Select whether or not you want to print a test page, and then click [Next>].

MMMM Click [Finish].

Printer driver installation starts.

Note

❒ During installation, the [Hardware Installation] dialog box may appear. In this case, click [Continue

Anyway] to continue the installation.

NNNN Set up the options.

Reference

For more information about option settings, see p.49 “Setting Up Options”.
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Changing Port Settings

Follow the procedure below to change SmartDeviceMonitor for Client settings, such as proxy server
settings or IPP URL.

AAAA In the [Printers and Faxes] window, click the icon of the printer you want to use. On the [File]
menu, click [Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration:] dialog box appears.

Note

❒ If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Client

icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each port]

check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

• For IPP, you can configure IPP User Settings, Proxy Settings, and Timeout Settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.
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Setting Up Options

You must set up installed options, paper size, and feed direction with the printer driver when bidirec-
tional transmission is disabled.

Limitation

❒ Changing the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission. 

Note

❒ The description uses the PCL 5c printer driver.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Printers and Faxes] window appears.

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Properties].

Note

❒ When you open the printer properties dialog box for the first time after installing the RPCS printer

driver, the confirmation window appears. After that, the initial display of the printer properties di-

alog box appears.

CCCC Click the [Accessories] tab.

Note

❒ If you are using the RPCS printer driver, click the [Change Accessories] tab.

❒ If you are using the PostScript 3 printer driver, click the [Device Settings] tab.
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DDDD Select options you have installed from the [Options] group, and then make any necessary set-

tings.

Note

❒ If you are using the RPCS printer driver, select the options from [Select printer options:]. 

❒ If you are using the PostScript 3 printer driver, select the options from [Installable Options].

EEEE Click [OK].
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----Bidirectional transmission

When bidirectional transmission is enabled, information about paper size and feed direction settings is
automatically sent to the printer by a computer. You can also check printer status from your computer.

• Bidirectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003,
and Windows NT 4.0.

• If you use the RPCS printer driver and bidirectional transmission is enabled, the [Change Accesso-
ries] tab is shaded, and cannot be used.

Note

❒ The RPCS printer driver supports bidirectional transmission and updates the printer status automat-

ically.

❒ The PCL 5c printer driver supports bidirectional transmission; you can update the printer status

manually.

❒ The PostScript 3 printer driver does not support bidirectional transmission.

Bidirectional transmission requires the following conditions:

❖❖❖❖ When connecting via parallel cable

• The computer must support bidirectional transmission.

• The printer must be set to bidirectional transmission.

• The interface cable must support bidirectional transmission.

• The machine must be connected to the computer using standard parallel cable and parallel con-
nector.

• Under Windows XP or Windows Server 2003 [Enable bidirectional support] must be selected and
[Enable printer pooling] must not be selected on the [port] tab with RPCS printer driver.
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❖❖❖❖ When connecting with the network

• The printer must be set to bidirectional transmission.

• SmartDeviceMonitor for Client included on the CD-ROM must be installed, and TCP/IP must
be used.

• Under Windows XP or Windows Server 2003 [Enable bidirectional support] must be selected and
[Enable printer pooling] must not be selected on the [port] tab with RPCS printer driver.
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Setting the Printer Shared

Limitation

❒ Changing the printer settings requires Manage Printers permission. Members of the Administrators

and Power Users groups have Manage Printers permission by default. When you set up options,

log on using an account that has Manage Printers permission.

AAAA Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Printers and Faxes] window appears.

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Properties].

CCCC Select the [Share this printer:] check box on the [Sharing] tab.

DDDD To share a printer with users running different versions of Windows, click [Additional Driv-
ers...], and then follow the instruction on the screen.

Note

❒ If you have installed an alternative driver by selecting the [Shared] check box, you do not have to

follow this step.

EEEE Click [OK].
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3. Windows NT 4.0 Print Server Configuration

To use a printer connected to the Ethernet interface, click [SmartDeviceMonitor] or [LPR Port] when in-
stalling the printer driver.

• SmartDeviceMonitor
See p.54 “Configuring the Protocols”, p.59 “Installing Software”, p.60 “Installing the PCL 5c or
RPCS Printer Driver”, and p.65 “Installing the PostScript Printer Driver”.

• LPR Port
See p.54 “Configuring the Protocols”, p.60 “Installing the PCL 5c or RPCS Printer Driver”, and
p.65 “Installing the PostScript Printer Driver”.

Note

❒ If you want to use “LPR Port”, “Microsoft TCP/ IP Printing” must be installed. For details, see

Windows NT 4.0 Help.

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

This describes how to configure the network interface board and Windows NT 4.0 to use TCP/IP and
IPP.

Configuring the printer

Configure the printer to use TCP/IP.

• Check TCP/IP is set to active. (The factory default is active.)

• Assign an IP address and make other settings required for TCP/IP.
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Reference

For more information about how to make the above settings, see “Windows NT 4.0 Configuration”,

Client Reference.

If DHCP is used to assign IP addresses, see p.72 “Bidirectional transmission”.

Note

❒ After setting the IP address, use the ping command to confirm that it has been set correctly.

A On the [Start] menu, point to [Programs], and then click [Command Prompt].

B Enter the following: (Example: IP address is 192.168.15.16)

C:> ping 192.168.15.16
If the address is configured correctly, the following message appears:

Reply from 192.168.15.16 : bytes=32 time<10ms TTL=32
If the address is configured incorrectly, the following message appears:

Request timed out.
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Configuring a Windows NT 4.0 computer

Follow the procedure below to configure a Windows NT 4.0 computer to use TCP/IP.

AAAA Open [Control Panel] and double-click the [Network] icon. Check “TCP/IP Protocol” is listed in

the [Network protocols] box on the [Protocols] tab.

Note

❒ If TCP/IP is not installed, click [Add] on the [Protocols] tab and install it. For more information

about installing TCP/IP, see Windows NT 4.0 Help.

BBBB Check TCP/IP with an appropriate IP address, subnet mask, and other settings.

Check the settings are correct with the network administrator.

CCCC Click the [Services] tab, and confirm that “Microsoft TCP/IP Printing” is installed.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services] tab, and install it. For
more information about installing and configuring network services, see Windows NT 4.0 Help.
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Configuring NetBEUI for Printing

This describes how to configure the network interface board and Windows NT 4.0 to use NetBEUI.

Preparation

To use NetBEUI, use the SmartDeviceMonitor for Client port.

Configuring the printer

Configure the printer to use NetBEUI.

• Check NetBEUI is set to active. (The factory default is active.)

Reference

For more information about how to make the above settings, see “Windows NT 4.0 Configuration”,

Client Reference.
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Configuring a Windows NT 4.0 computer

Install NetBEUI on the Windows NT 4.0 computer, and then change the LAN adapter number (Lana
Number).

AAAA Open [Control Panel] and double-click the [Network] icon. Check [NetBEUI Protocol] is listed in

the [Network Protocols] box on the [Protocols] tab.

Note

❒ If NetBEUI is not installed, click [Add...] on the [Protocols] tab, and install it. For more information

about installing NetBEUI, see Windows NT 4.0 Help.

BBBB Change the Lana Number. Click the [Services] tab, click [NetBEUI Interface] in the [Network
Services:] box, and then click [Properties:].

CCCC Click the Lana Number corresponding to the Nbf protocol of the [Network Route] headline, and

then click [Edit].

DDDD Enter “0” as the Lana Number.

Note

❒ If another protocol's Lana Number is configured to “0”, change it to another number.

EEEE Click [OK].

FFFF Click [Close].

GGGG After confirming the message to restart, click [Yes].

Note

❒ After you change the Lana Number, you must restart the computer.
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Installing Software

Installing SmartDeviceMonitor for Client

AAAA Quit all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Note

❒ Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.

CCCC Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

DDDD Click [SmartDeviceMonitor for Client/Admin].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [I accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

FFFF Follow the instructions on the screen.

Note

❒ If you are required to restart the computer after the installation of SmartDeviceMonitor for Client,

restart and continue configuration.
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Installing the PCL 5c or RPCS Printer Driver

AAAA Quit all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.

CCCC Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

DDDD Click [PCL/RPCS Printer Drivers].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [I accept the agreement.] to agree with the license agree-
ment, and then click [Next>].
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FFFF Select the printer drivers you want to use when the [Select Program] dialog appears, and then

click [Next>].

You can select more than one printer driver.

GGGG Select the [Printer Name] check box to select the printer model(s) you want to use.

To change the printer name, use the [Change settings for 'Printer Name'] box.

HHHH Double-click the printer name to display its settings.

Note

❒ The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-

ing used, model of printer selected, and port being used.

IIII Click [Port], and then click [Add] in the [Change settings for 'Port'] box.

JJJJ The next part of the procedure depends on the port in use. Follow the section that corresponds

to the port you want to use.

• SmartDeviceMonitor

• LPR Port

SmartDeviceMonitor

A Click [SmartDeviceMonitor], and then click [OK].

B Select the printer you want to use.

❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].
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Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then enter the printer's IP address or host

name.

❖❖❖❖ NetBEUI

A Click [NetBEUI], and then click [Search].
A list of printers that can be used with NetBEUI appears.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then enter the NetBEUI address. Check

the NetBEUI network address is on the configuration page. For more information about

the printing of configuration page, see p.134 “Printing a Configuration Page”. NetBEUI ad-

dress appears as “\\RNPxxxx\xxx” on a configuration page. Enter the printer's network

path name in form of “%%Computer name \Share name”. Do not enter “\\” as head char-

acters but “%%”.

❒ You cannot print to printers beyond routers.

❖❖❖❖ IPP

A Click [IPP].
The IPP settings dialog box appears.

B To specify the printer's IP address, enter “http://(printer's-ip-address)/ printer” or “ipp://(print-
er's-ip-address)/printer” in the [Printer URL] field.
(Example: IP address is 192.168.15.16)

http://192.168.15.16/printer
ipp://192.168.15.16/printer
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C If necessary, enter the names to distinguish the printer in [IPP Port Name]. Enter a different
name from those of existing port names.
If you do not do this, the address entered in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].

LPR Port

A Click [LPR Port], and then click [OK].

B In the [Name or address of server providing lpd] box, enter the printer's IP address.

C In the [Name of printer or print queue on that server] box, enter “lp”, and then click [OK].

KKKK Make sure the location for the selected printer is displayed after [Port].

LLLL Double-click [Shared] to display share settings.

MMMM To share the printer, select the [Shared] check box.

NNNN Check the boxes under [Share name] to install the alternative driver for the necessary system.

Note

❒ Select the [Shared] check box to start installation of an alternative driver ([Windows NT 4.0/2000]

and [Windows 95/98/Me] are already selected).

❒ You can add an alternative driver after installation. See p.74 “Setting the Printer Shared”.
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OOOO Configure the default printer as necessary.

❖❖❖❖ Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

PPPP Click [Continue] to start printer driver installation.

QQQQ When the [Select Program] dialog box appears, click [Finish].

RRRR When the [Installation completion.] dialog box appears, click [Finish].

SSSS Set up the options.

Note

❒ You must set up the options when bidirectional transmission is disabled. For more information

about bidirectional transmission status, see p.72 “Bidirectional transmission”.

Reference

For more information about option settings, see p.70 “Setting Up Options”.
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Installing the PostScript Printer Driver

AAAA Quit all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Important

❒ Never have two versions of the same printer driver installed on your system at the same time.

When upgrading to a new version of the printer driver, delete the old version, and then install the

new one.

Note

❒ Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.

CCCC Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

Note

❒ The printer driver with the selected language will be installed. The printer driver will be installed

in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

DDDD Click [PostScript 3 Printer Driver].

Add Printer Wizard starts.

EEEE Click [Next>].
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FFFF Click [Local printer], and then click [Next>].

GGGG Click [Add Port...].

HHHH The next part of the procedure depends on the port in use. Follow the section that corresponds

to the port you want to use.

• SmartDeviceMonitor

• LPR Port

SmartDeviceMonitor

A Click [SmartDeviceMonitor], and then click [New Port...].

B Select the printer you want to use.

❖❖❖❖ TCP/IP

A Click [TCP/IP], and then click [Search].
Available printers will be listed.

B Click the printer you want to use, and then click [OK].

Note

❒ Printers that respond to an IP broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then enter the printer's IP address or host

name.

❖❖❖❖ NetBEUI

A Click [NetBEUI], and then click [Search].
A list of printers that can be used with NetBEUI appears.

B Click the printer you want to use, and then click [OK].



Operating Instructions Administrator Reference

67

Note

❒ Printers that respond to a broadcast from the computer will be displayed. To print to a

printer not listed here, click [Specify Address], and then enter the NetBEUI address. Check

the NetBEUI network address is on the configuration page. For more information about

printing the configuration page, see p.134 “Printing a Configuration Page”. NetBEUI ad-

dress appears as “\\RNPxxxx\xxx” on the configuration page. Enter the printer's network

path name in the form of “%%Computer name\Share name”. Do not enter “\\” as head

characters but “%%”.

❒ You cannot print to printers beyond routers.

❖❖❖❖ IPP

A Click [IPP].
The IPP setting dialog box appears.

B To specify the printer's IP address, enter “http://(printer's-ip-address)/ printer” or “ipp://(print-
er's-ip-address)/printer” in the [Printer URL] field.
(Example: IP address is 192.168.15.16)

http://192.168.15.16/printer
ipp://192.168.15.16/printer

C If necessary, enter the names to distinguish the printer in [IPP Port Name]. Enter a different
name from those of existing port names.
If you do not do this, the address entered in [Printer URL] will be set as the IPP port name.

D If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.

E Click [OK].
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LPR Port

A Click [LPR Port], and then click [New Port...].

B In the [Name or address of server providing lpd] box, enter the printer's IP address.

C In the [Name of printer or print queue on that server] box, enter “lp”, and then click [OK].

D Click [Close] in the [Printer Ports] dialog box, and then click [Next>].

IIII Confirm to select the name of the printer whose driver you want to install, and then click

[Next>].

JJJJ Change the name of the printer if you want, and then click [Next>].

Configure the default printer as necessary. Select the [Yes] check box to set the printer as the default
printer.

KKKK Select the [Shared] check box, select the operating system as necessary, and then click [Next>].

To change the printer name, use the [Share Name:] box.

LLLL Select whether or not you want to print a test page, and then click [Finish].

MMMM Printer driver installation starts.

NNNN Set up the options.

Reference

For more information about option settings, see p.70 “Setting Up Options”.
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Changing Port Settings

This describes how to change SmartDeviceMonitor for Client settings, such as proxy server settings or
IPP URL.

Note

❒ There are no settings for NetBEUI.

AAAA In the [Printers] window, click the icon of the printer you want to use. On the [File] menu, click

[Properties].

BBBB Click the [Ports] tab, and then click [Configure Port].

The [Port Configuration:] dialog box appears.

Note

❒ If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below.

A Click [Cancel] to close the [Port Configuration:] dialog box.

B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Client

icon on the taskbar.

C Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each port]

check box.

D Click [OK] to close the [Extended Features Settings] dialog box.

• For IPP, you can configure User Settings, Proxy Settings, and Timeout Settings.

Note

❒ For more information about these settings, see SmartDeviceMonitor for Client Help.
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Setting Up Options

You must set up installed options, paper size, and feed direction with the printer driver when bidirec-
tional transmission is disabled.

Limitation

❒ Changing the printer settings requires Full Control Access permission. Members of the Administra-

tors and Power Users groups have Full Control Access permission by default. When you set up op-

tions, log on using an account that has Full Control Access permission. 

Note

❒ The description uses the PCL 5c printer driver.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Properties].

Note

❒ When you open the printer properties dialog box for the first time after installing the RPCS printer

driver, the confirmation window appears. After that, the initial display of the printer properties di-

alog box appears.

CCCC Click the [Accessories] tab.

Note

❒ If you are using the RPCS printer driver, click the [Change Accessories] tab.

❒ If you are using the PostScript 3 printer driver, click the [Device Settings] tab.
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DDDD Select options you have installed from the [Options] group, and then make any necessary set-

tings.

Note

❒ If you are using the RPCS printer driver, select the options from [Select printer options:]. 

❒ If you are using the PostScript 3 printer driver, select the options from [Installable Options].

EEEE Click [OK].
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----Bidirectional transmission

When bidirectional transmission is enabled, information about paper size and feed direction settings is
automatically sent to the printer by a computer. You can also check printer status from your computer.

• Bidirectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003,
and Windows NT 4.0.

• If you use the RPCS printer driver and bidirectional transmission is enabled, on Windows 95/98/Me,
the unavailable functions are shaded, and cannot be used.

Note

❒ The RPCS printer driver supports bidirectional transmission and updates the printer status automat-

ically.

❒ The PCL 5c printer driver supports bidirectional transmission; you can update the printer status

manually.

❒ The PostScript 3 printer driver does not support bidirectional transmission.

Bidirectional transmission requires the following conditions:

❖❖❖❖ When connecting via parallel cable

• The computer must support bidirectional transmission.

• The printer must be set to bidirectional transmission.

• The interface cable must support bidirectional transmission.

• The machine must be connected to the computer using standard parallel cable and parallel con-
nector.

• Under Windows NT 4.0 [Enable bidirectional support] must be selected and [Enable printer pool-

ing] must not be selected on the [port] tab with RPCS printer driver.
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❖❖❖❖ When connecting with the network

• The printer must be set to bidirectional transmission.

• SmartDeviceMonitor for Client included on the CD-ROM must be installed, and TCP/IP must
be used.

• Under Windows NT 4.0 [Enable bidirectional support] must be selected and [Enable printer pool-
ing] must not be selected on the [port] tab with RPCS printer driver.
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Setting the Printer Shared

Limitation

❒ Changing the printer settings requires Full Control Access permission. Members of the Administra-

tors and Power Users groups have Full Control Access permission by default. When you set up op-

tions, log on using an account that has Full Control Access permission.

Use the [Printers] window to set up the printer.

AAAA On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

BBBB Click the icon of the printer you want to use. On the [File] menu, click [Properties].

CCCC Select the [Shared] check box on the [Sharing] tab.

Note

❒ If you use alternate drivers for Windows 95/98/Me client, Service Pack 4 or later is required. In-

stall the appropriate printer driver for each client.

DDDD To share a printer with users running different versions of Windows, select the operating sys-

tem in the [Alternate Drivers:] box, and then follow the instruction on the screen.

Note

❒ If you have installed an alternate driver by selecting the [Shared] check box, you do not have to

follow this step.

EEEE Click [OK].

The printers attached to the network are displayed.
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4. NetWare Configuration

This describes how to configure the printer for use as a print server or remote printer in a NetWare en-
vironment.

Configuring the NetWare Protocol using the Control 
Panel

Note

❒ IPX/SPX must be installed on your computer. If it is not, see Windows Help for instructions.

AAAA Press the {{{{Menu}}}} key.

"Menu" appears on the panel display.

BBBB Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display "Host Interface".

ZHBS010E

  Menu:

   Host Interface
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CCCC Press the {{{{Enter #}}}} key.

The following message appears on the display.

DDDD Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display "Network Setup".

EEEE Press the {{{{Enter #}}}} key.

The following message appears on the display.

FFFF Select the NetWare.

Note

❒ All protocols are active by the default.

❒ Do not select protocols not used on your network.

❒ If you use Pure IP on NetWare 5/5.1, 6/6.5, configure the printer to active TCP/IP.

  Host Interface:

   I/O Buffer

  Host Interface:

   Network Setup

  Network Setup:

   IP Address
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A Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display "Active Protocol", and then press the {{{{Enter #}}}} key.

B Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display "NetWare".

C Press the {{{{Enter #}}}} key.

The current setting appears on the display.

D Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “NetWare”.

E Press the {{{{Enter #}}}} key.

After about two seconds, the display returns to “Active Protocol”.

F Press the {{{{Escape}}}} key.

The display returns to “Network Setup”.

GGGG Select the frame type for NetWare.

Select one of the following items if necessary.

• Auto  (Default)

• Ethernet 802.3

• Ethernet 802.2

• Ethernet ll

• Ethernet SNAP

  Active Protocol:

   TCP/IP

  NetWare:

  *Active



Operating Instructions Administrator Reference

78

Note

❒ In most situations, use the default setting ("Auto "). When you first select "Auto ", the frame type

first detected by the printer is adopted. If the network can use more than two frame types, the

printer may fail to select the correct frame type if "Auto " is selected. In this case, select the ap-

propriate frame type.

A Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display "Frame Type (NW)".

B Press the {{{{Enter #}}}} key.

The current setting appears on the display.

C Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display the frame type you want to use.

D Press the {{{{Enter #}}}} key.

In about two seconds, the display returns to "Network Setup".

E Press the {{{{On Line}}}} key.

"Ready" appears on the display.

  Network Setup:

   Frame Type (NW)

  Frame Type (NW):

  *Auto 

  Ready
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HHHH Print the configuration page to check settings you have made.

For more information about how to print a configuration page, see p.134 “Printing a Configuration
Page”.

❖❖❖❖ SmartDeviceMonitor for Admin
To use a printer in a NetWare environment, configure the NetWare printing environment using
SmartDeviceMonitor for Admin.

Note

❒ If you configure the NetWare printing using SmartDeviceMonitor for Admin under the follow-

ing environments, Novell NetWare Client is required:

• NDS mode in Windows 95/98/Me

• NDS or Bindary mode in Windows 2000/XP, Windows Server 2003, Windows NT 4.0

❒ Use the version of Novell Client provided with your operating system or the latest version.

❖❖❖❖ Printers listed by SmartDeviceMonitor for Admin
SmartDeviceMonitor for Admin displays a list of printers connected to the network.
If you cannot find out the printer from the displayed list, refer to the configuration page printed
from the printer. For more information about printing a configuration page, see p.134 “Printing
a Configuration Page”.
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the printer differ depending on whether the Network Interface
Board is configured as a print server or as a remote printer. This section describes how to configure it
in the NetWare 3.x environment.

Note

❒ This section assumes NetWare is functional and that the necessary environment for NetWare Print

Service is available.
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Installing SmartDeviceMonitor for Admin

Install SmartDeviceMonitor for Admin on your computer. For the installation procedure, see p.98 “In-
stalling SmartDeviceMonitor for Admin”.

After installing SmartDeviceMonitor for Admin, go to p.81 “Setting Up as a Print Server” to use this
computer as a print server, or to p.83 “Setting Up as a Remote Printer” to use it as a remote printer.

Setting Up as a Print Server

AAAA Log on to the file server as a Supervisor or the equivalent of a Supervisor.

BBBB Run SmartDeviceMonitor for Admin.

CCCC On the [Group] menu, point to [Search Device], and then click [IPX/SPX].

A list of printers appears.

Note

❒ If you cannot identify which printer to configure from the list of printers, print Configuration Page

from the printer and find the desired printer. For more information about printing the Configura-

tion Page, see p.134 “Printing a Configuration Page”. 

❒ If no printer name appears on the list, match the frame types of the IPX/SPX protocol between

the computer and printer. Use the [Network] dialog box of Windows to change the frame type of

the computer. For more information about changing the frame type of equipment, see p.75 “Con-

figuring the NetWare Protocol using the Control Panel”.

DDDD Select a printer you want to configure, and then click [NIB Setup Tool] on the [Tools] menu.

EEEE Click [Wizard], and then click [OK].
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FFFF Enter the device name in the [Device Name] box, a comment in the [Comment] box if necessary,

and then click [Next>].

GGGG Select the [NetWare] check box, and then click [Next].

HHHH Click [Bindery Mode], enter the file server name in the [File Server Name] box, and then click

[Next>].

In the [File Server Name] box, enter the name of the file server in which the print server is to be cre-
ated. You can also select a file server from the list that appears by clicking [Browse].

IIII Enter the print server name in the [Print Server Name] box, the printer name in the [Printer
Name] box, and the print queue name in the [Print Queue Name] box, then click [Next>].

• In the [Print Server Name] box, type the name of the NetWare print server within 47 characters.

• In the [Printer Name] box, enter the name of the NetWare printer.

JJJJ After confirming the settings, click [Next].

The settings take effect, and the NIB Setup Tool exits.

KKKK Exit SmartDeviceMonitor for Admin.

LLLL Turn the printer power off and on.

Note

❒ To confirm that the printer is configured correctly, type the following from the command prompt.

F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as an attached user.
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Setting Up as a Remote Printer

AAAA Log on to the file server as a Supervisor or the equivalent of a Supervisor.

BBBB Run the SmartDeviceMonitor for Admin.

CCCC On the [Group] menu, point to [Search Device], and then click [IPX/SPX].

A list of printers appears.

Note

❒ If you cannot identify which printer to configure from the list of printers, print the configuration

page and find it. For more information about printing the configuration page, see p.134 “Printing

a Configuration Page”.

❒ If no printer name appears on the list, match the IPX/SPX frame types between the computer

and printer. Use the [Network] dialog box of Windows to change the computer frame type. For

more information about changing equipment frame types, see p.75 “Configuring the NetWare

Protocol using the Control Panel”.

DDDD Select the printer you want to configure, and then click [NIB Setup Tool] on the [Tools] menu.

EEEE Click [Property Sheet], and then click [OK].

FFFF Click the [NetWare] tab, and then make the following settings:

A In the [Print Server Name] box, enter the name of the print server.

B In the [File Server Name] box, enter the name of the file server in which a print server is to

be created.

By clicking [Browse], you can select a file server among those listed in the [Browse] dialog box.

C In the [Print Server Operation Mode] group, click [As Remote Printer].
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D In the [Remote Printer No.] box, enter the printer number.

Important

❒ Use the same printer number as that to be created in the printer server.

E Click [OK] to close the property sheet.

F After a confirmation dialog box appears, click [OK].

GGGG On the [NIB] menu, click [Exit] to exit NIB Setup Tool.

HHHH Enter “PCONSOLE” after the command prompt.

F:> PCONSOLE

IIII Create a print queue as follows:

Note

❒ If you use a currently defined print queue, proceed to step J.

A On the [Available Options] menu, click [Print Queue Information], and then press {{{{Enter}}}}.

B Press {{{{INSERT}}}}, and then enter a print queue name.

C Press {{{{ESC}}}} to return to the [Available Options] menu.

JJJJ Create a printer as follows:

A On the [Available Options] menu, click [Print Server Information], and then press {{{{Enter}}}}.

B To create a new print server, press {{{{INSERT}}}}, and then enter a print server name.

If you are using a currently defined print server, select one of the print servers shown in the [Print
Server] list.

Important

❒ Use the same name as that specified in NIB Setup Tool. (Step F - A).
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C On the [Print Server Information] menu, click [Print Server Configuration].

D On the [Print Server Configuration] menu, click [Printer Configuration].

E Select the printer which is indicated as “Not Installed”.

Important

❒ Use the same number as that specified as the Remote Printer No. using NIB Setup Tool.

(Step F - D).

F If you want to change the name of the printer, enter a new name.

The name “Printer x” is assigned to the printer. The “x” stands for the number of the selected
printer.

G For type, click [Remote Parallel, LPT1].

IRQ, Buffer size, Starting form, and Queue service mode are automatically configured.

H Press the {{{{ESC}}}} key, and then click [Yes] in the confirmation dialog box.

I Press the {{{{ESC}}}} key to return to [Print Server Configuration Menu].

KKKK Assign print queues to the created printer as follows:

A From [Print Server Configuration Menu], click [Queues Serviced By Printer].

B Select the printer created in step J.

C Press the {{{{INSERT}}}} key to select a queue serviced by the printer. 

Note

❒ You can select more than one queue at a time.

D Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, check the queues are assigned.

LLLL Press the {{{{ESC}}}} key until “Exit?” appears, and then click [Yes] to close PCONSOLE.
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MMMM Start the print server by entering the following from the console of the NetWare Server:

 If it is running, restart it after exiting it.

❖❖❖❖ To exit

CAREE: unload pserver

❖❖❖❖ To start

CAREE: load pserver print_server_name

Note

❒ If the printer works as configured, “Waiting for job” appears.
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NetWare 4.x, 5/5.1, 6/6.5 - Advanced Settings

The procedure for configuring the printer differ depending on whether the network interface board is
configured as a print server or remote printer. This section describes how to configure it in a NetWare
4.x, 5/5.1, 6/6.5 environment.

❖❖❖❖ To use NetWare 5/5.1, 6/6.5

• Use the printer as a print server.
Do not use as a remote printer.

• If you use Pure IP, configure the printer to use TCP/IP. For more information about how to make
the settings, see p.75 “Configuring the NetWare Protocol using the Control Panel”.
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Installing SmartDeviceMonitor for Admin

Install SmartDeviceMonitor for Admin on your computer. For the installation procedure, see p.98 “In-
stalling SmartDeviceMonitor for Admin”.

After installing SmartDeviceMonitor for Admin, go to p.88 “Setting Up as a Print Server” to use this
computer as a print server, or to p.92 “Setting Up as a Remote Printer” to use it as a remote printer.

Setting Up as a Print Server

Important

❒ You must set up the print server using NDS mode in NetWare 4.x, 5/5.1, 6/6.5.

AAAA Log on to the file server as a Supervisor or the equivalent of a Supervisor.

BBBB Run SmartDeviceMonitor for Admin.

CCCC On the [Group] menu, point to [Search Device], and then click [IPX/SPX] or [TCP/IP].

A list of printers appears.

Note

❒ If you use Pure IP, click [TCP/IP].

❒ If you cannot identify which printer to configure from the list of printers, print the configuration

page and find it. For more information about printing the configuration page, see p.134 “Printing

a Configuration Page”.

❒ If no printer name appears in the list, match the IPX/SPX frame types between the computer and

printer. Use the [Network] dialog box of Windows to change the computer frame type. For more

information about changing equipment frame types, see p.75 “Configuring the NetWare Protocol

using the Control Panel”.
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DDDD Select the printer you want to configure, and then click [NIB Setup Tool] on the [Tools] menu.

Reference

If you use Pure IP, see p.90 “Using Pure IP in the NetWare 5/5.1, 6/6.5 Environment”.

EEEE Click [Wizard], and then click [OK].

FFFF Enter the device name in the [Device Name] box, a comment in the [Comment] box if necessary,

and then click [Next>].

GGGG Select the [NetWare] check box, and then click [Next>].

HHHH Click [NDS Mode], enter the file server name in the [File Server Name:] box, the NDS tree name

in the [NDS Tree] box and the context in the [NDS Context:] box, and then click [Next>].

In the [File Server Name:] box, enter the name of the file server in which the print server is to be
created. You can also select a file server from the list that appears by clicking [Browse].

By clicking [Browse], you can select a NDS context from those listed in the [Browse] dialog box.

For context, object names are entered from a lower object and divided by a period. For example, if
you want to create a print server into NET under DS, enter “NET.DS”.

IIII Enter the print server name in the [Print Server Name] box, the printer name in the [Printer
Name] box, the print queue name in the [Print Queue Name] box, and the print queue volume in

the [Print Queue Volume], and then click [Next>].

• In the [Print Server Name] box, enter the name of the NetWare print server using up to 47 char-
acters.

• In the [Printer Name] box, enter the name of the NetWare printer.

• In the [Print Queue Name] box, enter the name of the print queue to be added to NetWare.

• In [Print Queue Volume], enter the print queue volume. As a volume, object names are entered
from a lower object and divided by a period. You can select a volume by clicking [Browse].
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JJJJ After confirming the settings, click [Next>].

The settings take effect, and NIB Setup Tool closes.

KKKK Exit SmartDeviceMonitor for Admin.

LLLL Turn the printer power off and on.

Note

❒ To check the printer is configured correctly, enter the following after the command prompt:

F:> NLIST USER /A/B

❒ If the printer works as configured, the name of the print server appears as an attached user.

Using Pure IP in the NetWare 5/5.1, 6/6.5 Environment

AAAA Log on to the file server as an Admin or the equivalent of an Admin.

BBBB Run SmartDeviceMonitor for Admin.

CCCC Click [Property Sheet], and then click [OK].

The [NIB Setup Tool] dialog box appears.

DDDD Click the [NetWare] tab, and make the following settings:

A In the [Print Server Name] box, enter the name of the print server.

B In the [File Server Name] box, enter the name of the file server in which a print server is to

be created.

By clicking [Browse], you can select a file server among those listed in the [Browse File Server]
dialog box.
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C In the [NDS Context:] box, enter the context of the print server.

By clicking [Browse], you can select NDS tree and NDS context from those listed in the [Browse
Context] dialog box.

For context, object names are entered from a lower object and divided by a period. For example,
if you want to create a print server into Net under DS, enter “NET.DS”:

D In the [Print Server Operation Mode] group, click [As Print Server].

E Click [OK] to close the property sheet.

F After the confirmation dialog box appears, click [OK].

EEEE Exit SmartDeviceMonitor for Admin.

After this step, proceed to step H on p.92 “Setting Up as a Remote Printer”.
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Setting Up as a Remote Printer

AAAA Log on to the file server as an Admin or the equivalent of an Admin.

BBBB Run the SmartDeviceMonitor for Admin.

CCCC On the [Group] menu, point to [Search Device], and then click [IPX/SPX].

A list of printers appears.

Note

❒ If you cannot identify which printer to configure from the list of printers, print the configuration

page and find it. For more information about printing the configuration page, see p.134 “Printing

a Configuration Page”.

❒ If no printer name appears on the list, match the IPX/SPX frame types between the computer

and printer. Use the [Network] dialog box of Windows to change the computer frame type. For

more information about changing equipment frame types, see p.75 “Configuring the NetWare

Protocol using the Control Panel”.

DDDD Select the printer you want to configure, and then click [NIB Setup Tool] on the [Tools] menu.

EEEE Click [Property Sheet], and then click [OK].

FFFF Click the [NetWare] tab, and make the following settings:

A In the [Print Server Name] box, enter the name of the print server.

B In the [File Server Name] box, enter the name of the file server in which a print server is to

be created.

By clicking [Browse], you can select a file server among those listed in the [Browse] dialog box.
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C In the [NDS Context] box, enter the context in which the print server is to be created.

By clicking [Browse], you can select a context from those listed in the [Browse] dialog box.

For context, object names are entered from a lower level object and divided by a period. For ex-
ample, if you want to create a print server into NET under DS, enter “NET.DS”:

D In the [Print Server Operation Mode] group, click [As Remote Printer].

E In the [Remote Printer No.] box, enter the number of the printer.

Important

❒ Use the same number as that of the printer to be created in the print server.

F Click [OK] to close the property sheet.

GGGG On the [NIB] menu, click [Exit] to exit NIB Setup Tool.

HHHH From Windows, run NWadmin.

Reference

For more information about NWadmin, see the documentation provided with NetWare.

IIII Create a print queue as follows:

A Select the container object the print queue is located in among those in the directory tree,

and then click [Create] on the [Object] menu.

B In the [Class of new object] box, click [Print Queue], and then click [OK].
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C In the [Print Queue name] box, enter the name of the print queue.

D In the [Print Queue Volume] box, click [Browse].

E In the [Available objects] box, click the volume in which the print queue is created, and then

click [OK].

F After confirming the settings, click [Create].

JJJJ Create a printer as follows:

A Select the container object the printer is located in, and then click [Create] on the [Object]
menu.

B In the [Class of new object] box, click [Printer], and then click [OK]. When you are using Net-

Ware 5/5.1, 6, click [Printer (Non NPDS)].

C In the [Printer name] box, enter the name of the printer.

D Select the [Define additional properties] check box, and then click [Create].

KKKK Assign print queues to the created printer as follows:

A Click [Assignments], and then click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in step I, and then click [OK].

C Click [Configuration], and in the [Printer type] list, click [Parallel], and then click [Communi-

cation]. 

D Click [Manual load] in the [Communication type] group, and then click [OK].

E After confirming the settings, click [OK].

LLLL Create a print server as follows:

A Select the context specified using NIB Setup Tool (Step I - AAAA), and on the [Object] menu,

click [Create].
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B In the [Class of new object] box, click [Print Server], and then click [OK]. When you are using

NetWare 5/5.1, 6/6.5, click [Print Server (Non NPDS)].

C In the [Print Server name] box, enter the name of the print server.

Important

❒ Use the same name as that specified using NIB Setup Tool. (Step F - A).

D Select the [Define additional properties] check box, and then click [Create].

MMMM Assign the printer to the created print server as follows:

A Click [Assignments], and then click [Add] in the [Assignments] group.

B In the [Available objects] box, click the queue created in step K, and then click [OK].

C In the [Printers] group, click the printer assigned in step BBBB, and then click [Printer Number].

D Enter the printer number, and then click [OK].

Important

❒ Use the same number as that specified as Remote Printer No. using NIB Setup Tool. (Step

F - E).

E After confirming the settings, click [OK].

NNNN Start the print server by typing the following from the console of the NetWare Server.

If it is running, restart it after closing.

❖❖❖❖ To exit
CAREE: unload pserver

❖❖❖❖ To start
CAREE: load pserver print_server_name
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5. Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you cannot only monitor the status of network printers, but also
change configuration of the network interface board using TCP/IP or IPX/SPX.

SmartDeviceMonitor for Admin is equipped with the following functions;

• Device Information function

• Checks the printer's network settings and device details.

• Checks the number of pages printed for each computer, using the user codes.

• Checks the results of print jobs executed from the computer.

• Enables you to change the printer's network settings.

• Device Settings function

• Limits settings done from the control panel, and disables changes made to certain items.

• Enables the selection of paper type loaded in the printer.

• Energy Saver function

• Switches to, and wakes up from Energy Saver mode.

• System Status function

• Checks information about printing, paper quantity, and such, on the computer.

• Groups function

• Monitors multiple printers at the same time. When there are many printers, you can create groups
and classify the printers to facilitate management.
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Note

❒ Select the appropriate protocol stack for your operating system.

Operating system Protocol stack

Microsoft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare network client provided with Windows 95/98

Novell Client for Windows 95/98

Microsoft Windows 2000 TCP/IP provided with Windows 2000

IPX/SPX provided with Windows 2000

NetWare Client provided with Windows 2000

Novell Client for Windows NT/2000

Microsoft Windows XP TCP/IP provided with Windows XP

IPX/SPX provided with Windows XP

NetWare Client provided with Windows XP

Novell Client for Windows XP

Microsoft Windows Server 2003 TCP/IP provided with Windows Server 2003

IPX/SPX provided with Windows Server 2003

Microsoft Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT

Novell Client for Windows NT/2000



Operating Instructions Administrator Reference

98

Installing SmartDeviceMonitor for Admin

AAAA Quit all applications that are running.

BBBB Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

Note

❒ Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.

CCCC Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

DDDD Click [SmartDeviceMonitor for Client/Admin].

EEEE The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [I accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

FFFF Follow the instructions on the screen.

Note

❒ If you are required to restart the computer after the installation of SmartDeviceMonitor for Admin,

restart and continue configuration.
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Changing the Network Interface Board Configuration

AAAA Start SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then click [TCP/IP] or [IPX/SPX]. A list of

printers appears.

Note

❒ Select the protocol of the printer for which you want to change configuration.

CCCC In the list, select the printer for which you want to change configuration.

DDDD On the [Tools] menu, click [NIB Setup Tool].

NIB Setup Tool starts.

EEEE Click [Wizard] or [Property Sheet], and then click [OK].

• When configuring the network interface board for the first time, click [Wizard].

• When changing configuration of the network interface board or configuring details, click [Prop-
erty Sheet].

Selecting [Wizard]

A Enter the necessary items, and then follow the instructions on the screen.

Selecting [Property Sheet]

A A configuration list appears in the dialog box.

For more information about each item in the dialog box, see SmartDeviceMonitor for Admin Help.
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Changing Names and Comments

You can change printer names and attach comments to help identify printers listed on SmartDevice-
Monitor for Admin.

SmartDeviceMonitor for Admin allows you to change names and comments when TCP/IP or IPX/SPX
is available. You can install SmartDeviceMonitor for Admin from the CD-ROM provided. For more
information about installing SmartDeviceMonitor for Admin, see p.98 “Installing SmartDeviceMoni-
tor for Admin”.

The following utilities are used to change printer names and comments:

Note

❒ Each of the names, in TCP/IP form (printer name) and NetBEUI form, is changed individually. Com-

ments are, however, common to both protocols.

❒ The factory default name consists of “RNP” and the last 3 bytes of the MAC address on the network

interface board. For example, if the MAC address is 00:00:74:62:7D:D5, the factory default name is

“RNP627DD5”. Comments are not configured.

AAAA Start SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and click [TCP/IP] or [IPX/SPX]. A list of print-

ers appears.

Note

❒ Select the protocol of the printer for which you want to change configuration.

CCCC In the list, select the printer for the network interface board you want to change configuration.

DDDD On the [Tools] menu, click [NIB Setup Tool].

NIB Setup Tool starts.

EEEE Click [Property Sheet], and then click [OK].
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TCP/IP

A Click the [General] tab, and then enter the device name in the [Device Name] box and com-

ment in the [Comment] box.

• In the [Device Name] box, enter the name of the printer using up to 47 characters. The factory
default name consists of “RNP” and the last 3 bytes of the MAC address on the network in-
terface board. For example, if the MAC address is 00:00:74:62:7D:D5, the factory default
name is “RNP627DD5”. Nine character names are not permitted if the prefix is “RNP”. Also,
if DHCP is selected as an IP address setting, the number of characters is limited to 47.

• In the [Comment] box, enter a printer comment using up to 31 characters.

NetBEUI

A Click the [General] tab, and then enter the comment in the [Comment] box.

In the [Comment] box, enter a printer comment using up to 31 characters.

B Click the [NetBEUI] tab.

C Enter the computer name in the [Computer Name] box.

• In the [Computer Name] box, enter a name to help identify the printers using NetBEUI. The
factory default name consists of “RNP” and the last 3 bytes of the MAC address on the net-
work interface board. For example, if the MAC address is 00:00:74:62:7D:D5, the factory de-
fault name is “RNP627DD5”. A maximum of 47 characters consisting of uppercase
alphabetical letters, numbers, or symbols (except “*+,/:;<=>?[\]|. and space) can be used. No
name is permitted if the prefix is “RNP”. You must avoid using same names on a network.

FFFF Click [OK].

NIB Setup Tool closes, and the setting is transmitted to the printer.

GGGG Exit SmartDeviceMonitor for Admin.
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Displaying Printer Status

You can view the status of printers using SmartDeviceMonitor for Admin, SmartDeviceMonitor for
Client, or Web browser.

AAAA Start SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then click [TCP/IP] or [IPX/SPX].

Printer status is indicated by an icon in the list.

Note

❒ For more information about status icons, see SmartDeviceMonitor for Admin Help.

CCCC To see detailed status information, click the desired printer in the list, and then click [Open]
on the [Device] menu.

Printer status is displayed in the dialog box.

Note

❒ For more information about dialog box items, see Help.
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Locking the Menus on the Printer's Control Panel

AAAA Start SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then click [TCP/IP] or [IPX/SPX].

A list of printers appears.

Note

❒ Select the protocol of the printer for which you want to change configuration.

CCCC Select a desired printer.

DDDD On the [Tools] menu, point to [Device Settings], and then click [Lock Operation Panel Menu].

The Web browser starts, and a screen prompting you to enter the user name and password appears.

EEEE Enter the user name and password, and then click [OK].

To use the factory default account, enter no user name and enter “password” for the password.

The general configuration window appears.

FFFF In the [Lock Operation Panel Menu] list, click [Enable].

Note

❒ The Panel Lock function that can be set here is the same as that on the control panel of this ma-

chine.

GGGG Click [Apply].

HHHH Exit the Web browser.
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Changing the Paper Type

AAAA Start SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then click [TCP/IP] or [IPX/SPX].

A list of printer appears.

Note

❒ Select the protocol of the printer for which you want to change configuration.

CCCC In the list, select the printer whose paper type you want to change.

DDDD On the [Tools] menu, point to [Device Settings], and then click [Select Paper Type].

The Web browser starts, and a screen prompting you to enter the user name and a password appears.

EEEE Enter the user name and the password, and then click [OK].

To use the factory default account, enter no user name and enter “password” for the password.

The paper type configuration window appears.

FFFF Select the paper type, and then click [Apply].

GGGG Exit the Web browser.
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Managing the Number of Copies to be Printed

Preparation

Optional user account enhance unit must be installed to manage the number of copies to be printed.

For more information about installing user account enhance unit, see “User Account Enhance Unit

Type B”, Option Setup Guide.

AAAA Start SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then click [TCP/IP] or [IPX/SPX].

A list of printers appears.

Note

❒ Select the protocol of the printer for which you want to change configuration.

CCCC In the list, select the printer whose statistics you want to manage.

DDDD On the [Tools] menu, click [User Management Tool].

A screen prompting you to enter a password appears.

EEEE Enter the password, and then click [OK].

Note

❒ The factory default password is “password”.

The User Management Tool starts.

For more information about using User Management Tool, see SmartDeviceMonitor for Admin
Help.
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Configuring Energy Save Mode

AAAA Start SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then click [TCP/IP] or [IPX/SPX].

A list of printers appears.

Note

❒ Select the protocol of the printer for which you want to change configuration.

CCCC Select the device you want to make a setting for.

You do not need to select anything if you want to make a setting for all devices in the group.

DDDD Click [Group] and point to [Energy Save Mode].

EEEE To make a setting only for the device you have selected, click [Set Individually].

FFFF To make a setting for all the devices in the group, click [Set By Group].

GGGG Then, select an energy saver mode from the menu that appears.
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Setting a Password

AAAA Start SmartDeviceMonitor for Admin.

BBBB Click the [Group] menu, point to [Search Device], and then click [TCP/IP] or [IPX/SPX].

A list of printer appears.

Note

❒ Select the protocol of the printer for which you want to change configuration.

CCCC In the list, select the printer for which you want to change configuration.

DDDD On the [Tools] menu, click [NIB Setup Tool].

NIB Setup Tool starts.

Note

❒ To prevent the network interface board configuration from being changed accidentally by some-

one other than the network administrator, you can set a password in [NIB Setup Tool] that is dif-

ferent from the network password. Click [Option] to set a password in [NIB Setup Tool].

EEEE Click [Property Sheet], and then click [OK].

FFFF Click the [Password] tab.

GGGG Select the [Change Password] check box, enter a password, and then click [OK].
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6. Using a Web Browser

The Network Interface Board functions as a Web server or as a network printer. You can use a Web
browser to view the printer status and configure the Network Interface Board.

❖❖❖❖ Configuring the printer
This requires TCP/IP to be installed. After the printer has been configured to use TCP/IP, it will be
possible to adjust the settings using a Web browser.

Reference

For more information about configuring the printer to use TCP/IP, see “CONFIGURING THE

PRINTER FOR THE NETWORK”, Quick Installation Guide.

❖❖❖❖ Browser requirements

• Microsoft Internet Explorer 4.01 or later

• Netscape Navigator 4.06 or later
Operating systems the browser is guaranteed to run on are all supported.

Limitation

❒ If the Web browser in use is older than the recommended version or [Java Script] and [Cookie] are

not available, display and operation problems may occur.

❒ If you are using a proxy server, change the Web browser settings. Consult your network admin-

istrator about the settings.

❒ Sometimes after clicking [Back], the previous page may not appear. If this happens, click [Re-

fresh] or [Reload].

❒ The text on screen may disappear or be aligned incorrectly if browser font size settings are too

large. It is recommended that you use a font size equal to or smaller than “10 points” with Net-

scape Navigator, and “Medium” or smaller with Internet Explorer.
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Going to the Top Page

After launching the Web browser, enter the printer's IP address. See the example below. (This example
is for the English version.)

http://192.168.15.16/

(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

Note

❒ If a DNS server is used on the network, you can type the host name as an URL. For example, ht-

tp://webmonitor.netprinter.com/. In order to do this, you must register the IP address and the host

name of the Network Interface Board with the DNS server. Consult the network administrator for in-

formation about how to do this.

❒ When you use the proxy server, you must set up the proxy server address for the Web browser you

are using. Consult the network administrator for information about how to set the proxy server.
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1. Header Buttons

You can register favorite URLs with [URL]. To
view the Help section, click [Help].

Important

❒ It costs to use the browser to access a Web-

site.

Note

❒ The Help file is stored in the following folder
on the CD-ROM in HTML format. The third
folder, “(Language)” may be substituted by
an appropriate language name.

\HELP\WSMHLP\(Language)\

2. Menu Buttons

Buttons to configure the Network Interface Board
and confirm the status of the printer.

Note

❒ When you click [Network Config], a dialog
box appears requesting the user name and

a password. Enter only the password in this
dialog box. The factory default password is
“password”.

❒ The password is the same as that used for
remote maintenance and that used in the
NIB Setup Tool. If you change a password

with the Web browser, other passwords are
also changed.

3. Status

Displays the name and comments of the Network
Interface Board, and the printer status.
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Configuring the Network Interface Board Settings

AAAA Start the Web browser.

BBBB Point your browser at the URL or IP address of the printer (e.g. http://XXX.XXX.XXX.XXX

where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web browser.

CCCC Click [Configuration].

The dialog box for entering the password and user name is displayed.

DDDD Enter your user name and password, and then click [OK].

To use the factory default account, enter no user name and type “password” for the password.

EEEE Click the item you want to configure, and then make all the settings.

The following items can be configured:

❖❖❖❖ [General]
Configure the general settings for the machine here.

❖❖❖❖ [TCP/IP]
Configure the TCP/IP-related settings for the Network Interface Board, the optional 802.11b In-
terface Unit, and the optional 1394 Interface Unit.

❖❖❖❖ [SNMP]
Configure the appropriate community settings here. Up to 10 types of community names can be
registered.

❖❖❖❖ [NetWare]
Configure the settings for printing in a NetWare environment here.
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❖❖❖❖ [AppleTalk]
Configure the Network Interface Board or the optional 802.11b Interface Unit settings related to
the AppleTalk protocol.

❖❖❖❖ [NetBEUI]
Configure the Network Interface Board or the optional 802.11b Interface Unit settings related to
the NetBEUI protocol here.

❖❖❖❖ [IEEE 1394]
Configure the optional 1394 Interface Unit settings related to IP over 1394 and SCSI print (SBP-2).

Limitation

❒ This page is displayed when the optional 1394 Interface Unit is installed.

❖❖❖❖ [IPP Authentication]
If using the IPP protocol, configure the authentication settings for printing here.

❖❖❖❖ [Paper Type]
Select the paper type loaded in the machine from the drop-down menu.

❖❖❖❖ [Password]
Follow the procedure below to change the password.
Enter the password to change the network and machine settings or delete spooled print jobs.

❖❖❖❖ [IEEE 802.11b (Wireless LAN)]
Configure the optional 802.11b Interface Unit settings related to communication.

Limitation

❒ This page is displayed when the optional 802.11b Interface Unit is installed.
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Verifying the Network Interface Board Settings

AAAA Start the Web browser.

BBBB Point your browser at the URL or IP address of the printer (e.g. http://XXX.XXX.XXX.XXX

where the Xs are the number of the IP address).

The status of the printer you chose appears on the Web browser.

CCCC Click [Config. Reference].

The dialog box for entering the password and user name is displayed.

DDDD Click the item you want to check.

The following items can be checked:

❖❖❖❖ [General]
Shows general settings for the machine.

❖❖❖❖ [TCP/IP]
Shows the TCP/IP-related settings for the Network Interface Board, the optional 802.11b Inter-
face Unit, and the optional 1394 Interface Unit.

❖❖❖❖ [NetWare]
Shows the settings for printing in a NetWare environment.

❖❖❖❖ [AppleTalk]
Shows the Network Interface Board or the optional 802.11b Interface Unit settings related to the
AppleTalk protocol.
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❖❖❖❖ [NetBEUI]
Shows the Network Interface Board or the optional 802.11b Interface Unit settings related to the
NetBEUI protocol.

❖❖❖❖ [IEEE 1394]
Shows the optional 1394 Interface Unit settings related to IP over 1394 and SCSI print (SBP-2).

❖❖❖❖ [IEEE 802.11b (Wireless LAN)]
Shows the optional 802.11b Interface Unit settings related to communication.

----Linking the address (URL) to the [Help] button

You can link the address (URL) of the [Help] button to the Help files on the computer or on a Web server.

A Copy the Help files on the CD-ROM to a desired location. The Help files are located in folders la-
beled with abbreviated language names. For example, English Help files are in the [EN] folder. Be
sure to copy the entire [EN] folder to the new location.

B Using a Web browser, navigate to the Top Page, and then click [Network config].

C Enter your password, (it is not necessary to enter a user name), and then click [OK].

D Enter the path to the Help files in the [Help URL] box.
If you copied the Help files to “C:\HELP\EN”, enter “file://C:/HELP/”. For example if you copied
the files to a Web server and the index URL is “http://a.b.c.d/HELP/EN/index.html”, enter “ht-
tp://a.b.c.d/HELP/”.

E Click [Apply].
When a warning message appears, select to continue the configuration.
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Changing Names and Comments

You can change printer names and attach comments using a Web browser.

Note

❒ Each of the names, in TCP/IP form (printer name) and NetBEUI form, is changed individually. Com-

ments are, however, common to both protocols.

❒ The factory default name consists of “RNP” and the last 3 bytes of the MAC address on the network

interface board. For example, if the MAC address is 00:00:74:62:7D:D5, the factory default name is

“RNP627DD5”. Comments are not configured.

AAAA Start the Web browser.

BBBB Enter the address “http:// (IP address of the printer you want to change the settings)”.

The status of the selected printer is displayed on the Web browser.

CCCC Click [Configuration].

A dialog box that prompts you to enter the user name and a password appears.

DDDD Enter the user name and the password, and then click [OK].

Enter only the password in this dialog box. The factory default password is “password”.

EEEE Change names and comments.

TCP/IP

A Click the [General] tab, and then enter the name into the [Printer Name] box and comment

into the [Comment] box.
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• In the [Printer Name] box, enter the name of the printer within 47 characters. The factory de-
fault name consists of “RNP” and the last 3 bytes of the MAC address on the network inter-
face board. For example, when the MAC address is 00:00:74:62:7D:D5, the factory default
name is “RNP627DD5”. No name of 9 characters is permitted if the prefix is “RNP”. Also,
when DHCP is selected as an IP address setting, the number of characters is limited to within
47 characters.

• In the [Comment] box, enter any comment on printers within 31 characters.

B Click the [IEEE 1394], and then enter the name into the [Device Name] box when you change

the device name for IEEE 1394 (IP over 1394) interface.

• In the [Device Name] box, enter the name of the printer within 47 characters. The factory de-
fault name consists of “RNP” and the last 5 bytes of the EUI-64 on the IEEE 1394 (IP over
1394) interface. For example, when the EUI-64 is 00:00:74:00:02:01:0A:66, the factory de-
fault name is “RNP0002010A66”. No name of 47 characters is permitted if the prefix is
“RNP”.

NetBEUI

A Click [NetBEUI].

B Enter the name into the [Computer Name] box and comment into the [Comment] box.

• In the [Computer Name] box, type the name that helps you to identify printers using the Net-
BEUI protocol. The factory default name consists of “RNP” and the last 3 bytes of the MAC
address on the network interface board. For example, when the MAC address is
00:00:74:62:7D:D5, the factory default name is “RNP627DD5”. A maximum of 47 charac-
ters consisting of uppercase English letters, numeric, or symbols (except "*+,/:;<=>?[\]|. and
space) can be used. No name is permitted if the prefix is “RNP”. You must avoid the dupli-
cation of the same name on a network.
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FFFF Click [Apply].

The setting is transmitted to the printer.

GGGG Exit the Web browser.
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Displaying Printer Status

You can view the status of printers using a Web browser.

AAAA Start the Web browser.

BBBB Enter the address “http:// (IP address of the printer whose status you want to view)”.

The status of the selected printer is displayed on the Web browser.

CCCC Click [Status] and you can check the status of the printer.

Note

❒ For more information about each item, see Help.
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7. Making Printer Settings with the Control Panel

Menu Chart

This section describes how to change the default settings of the printer and provides information about
the parameters included in each menu.

Category Function menu

Sample Print  *1 Select Action / Error File(s)

Locked Print  *1  Select Action / Error File(s)

Paper Input, see p.126 “Paper Input 
Menu”

Bypass Size

Paper Type

Tray Locking

Tray Priority

List/Test Print, see p.133 “List/Test 
Print Menu”

Config. Page

Menu List

Color Demo Page

PS Config. Page

PCL Config.Page

Hex Dump
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Maintenance, see p.140 “Mainte-
nance Menu”

Color Regist.

Image Density

Registration

PlainPaper Type

Envelope Type

Maint. Reset

HDD Format *2 

ROM Update *3 

4C.Graphic Mode

WL.LAN Signal *4 

WL.LAN Defaults

Print Area

Key Repeat

Menu Protect *5 

Series Prnt.Job *5 

Category Function menu
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System , see p.153 “System Menu” MisfeedRecovery

Prt. Err Report

Auto Continue

Memory Overflow

Copies

Printer Lang.

Sub Paper Size

Page Size

Duplex *6 

Energy Saver 1

E. Saver2 Timer

Unit of Measure

Resolution

B&W Page Detect

Spool Printing *2 

Letterhead Mode *5 

E.Saver2 OnOff *5 

Category Function menu
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*1 The "Sample Print" menu and the "Locked Print" menu appear only when the optional Printer Hard Disk
is installed.

*2 The “HDD Format” and the "Spool Printing" menu appears only when the optional Printer Hard Disk is
installed.

*3 ROM Update is not currently used.

Host Interface, see p.163 “Host Inter-
face Menu”

I/O Buffer

I/O Timeout

Network Setup *7 

IEEE 1394 Setup *8 

IEEE 802.11b *9 

USB Setting *5 

PCL Menu, see p.175 “PCL Menu” Orientation

Form Lines

Font Source

Font Number

Point Size

Font Pitch

Symbol Set

Ext. A4 Width

Append CR to LF

Language, see p.181 “Language Menu”

Category Function menu
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*4 The "WL.LAN Signal" menu appears only when "IEEE 802.11b" is selected in "LAN Type" in the Host
Interface menu. 

*5 While the printer is On Line, press the {{{{Enter #}}}} key, and then press the {{{{Escape}}}} key, finally press the
{{{{Menu}}}} key. You can access the "Menu Protect", "Series Prnt.Job" "Letterhead Mode", "E.Saver2
OnOff", "USB Setting" on the panel display.

*6 The “Duplex” menu appears only when the optional AD440 is installed.
*7 The “Network Setup” menu appears only when the optional Network Interface Unit or 802.11b Interface

Unit is installed.
*8 The “IEEE 1394 Setup” menu appears only when the optional 1394 Interface Unit is installed.
*9 The “IEEE 802.11b” menu appears only when the optional 802.11b Interface Unit is installed.
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Accessing the Main Menu

Press the {{{{Menu}}}} key, and “Menu” appears on the display.

This menu shows the following 9 items which can be displayed one by one by pressing the {{{{UUUU}}}} or {{{{TTTT}}}} key.

• Sample Print

• Locked Print

• Paper Input

• List/Test Print

• Maintenance

• System 

• Host Interface

• PCL Menu

• Language

Note

❒ If the optional printer hard disk is not installed, the Sample Print menu and Locked Print menu can-

not be displayed on the control panel.

ZHBS010E
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❒ {{{{TTTT}}}}: Press to go to the next page.

❒ {{{{UUUU}}}}: Press to go back to the previous page.

❒ After making the printer settings, be sure to return to the previous menu by pressing the {{{{Escape}}}} key.

❒ After making the printer settings, press the {{{{On Line}}}} key to return to the “Ready” condition.

❒ The revised settings are not canceled, even if the power switch is turned off.

ZHBS020E

ZHBS050E
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Paper Input Menu

You can make the following settings from the Paper Input menu:

• Bypass Size

• Paper Type

• Tray Locking

• Tray Priority

Reference

For more information about loading paper in the tray, see Option Setup Guide.

Paper Input Parameters

Menu Description

Bypass Size The paper size for the bypass tray.

For more information about paper sizes that can be set in the bypass tray, see “Pa-
per and Other Media Supported by This Printer”, Maintenance Guide.

8 1/2 x 14, 8 1/2 x 11, 5 1/2 x 8 1/2, 7 1/4 x 10 1/2, 8 x 13, 8 1/2 x 13, 8 1/4 x 13, 
A4 (210x297), B5JIS (182x257), A5 (148x210), A6 (105x148), 16K (195x267), 
4 1/8 x 9 1/2, 3 7/8 x7 1/2, C5 Env(162x229), C6 Env(114x162), DL 
Env(110x220), Custom Size

Note

❒ Default: A4 (210x297) (Metric version), 11 x 8 1/2 (Inch version)
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Paper Type If you use different kinds of paper, set the paper type for Tray 1, Tray 2, Tray 3 
or Bypass Tray. 

For more information about paper sizes that can be set in each tray, see Mainte-

nance Guide.

❖❖❖❖ Tray 1, Tray 2, Tray 3
Plain Paper, Recycled Paper, Special Paper, Color Paper, Letterhead, Pre-
printed, Prepunched, Bond Paper

❖❖❖❖ Bypass Tray
Plain Paper, Recycled Paper, Special Paper, Color Paper, Letterhead, Pre-
printed, Prepunched, Labels, Bond Paper, Cardstock, Transparency, Thick 
Paper, Thick:Dup.Back, Glossy Paper

Note

❒ Default : Plain Paper

❒ Only installed trays appear on the display.

Menu Description
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Tray Locking If you use different kinds of paper, you can lock a tray to prevent printing on 
wrong paper such as letterhead or colored paper. When “Auto Select” is selected 
in the Paper Source selections from the printer driver, the locked tray will not be 
used. You can select each tray set to on or off.

Tray 1, Tray 2, Tray 3

Note

❒ Default : Off

❒ Only installed trays appear on the display.

❒ You can lock multiple trays.

❒ If you want to use a locked tray, you must select it from the printer 

driver and control panel.

❒ If a locked tray is selected from the printer driver, the printer does 

not search for another.

Tray Priority You can set which tray should be checked first when “Auto tray Select” is select-
ed in the Paper Source selections from the printer driver. When printing from 
DOS, the tray selected here is used when no tray is selected for a print job.

Tray 1, Tray 2, Tray 3

Note

❒ Default : Tray 1

❒ Only installed trays appear on the display.

❒ It is recommended that you load paper of the size and direction you 

most frequently use in the tray selected with “Tray Priority”.

Menu Description
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Changing the Paper Input Menu

Tray Locking

AAAA Press the {{{{Menu}}}} key.

“Menu” appears on the display.

BBBB Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Paper Input”, and then press the {{{{Enter #}}}} key.

ZHBS010E

  Menu:

   Paper Input
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CCCC Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Tray Locking”, and then press the {{{{Enter #}}}} key.

DDDD Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display the tray to change the tray locking off, and then press the

{{{{Enter #}}}} key.

Note

❒ The bypass tray cannot be locked.

EEEE Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Off”, and then press the {{{{Enter #}}}} key.

Wait for two seconds.

“Paper Input” appears on the panel display.

FFFF Press the {{{{On Line}}}} key.

“Ready” appears on the display.

  Paper Input:

   Tray Locking

  Tray Locking:

   Tray 1

  Tray 1:

  *Off
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Tray Priority

AAAA Press the {{{{Menu}}}} key.

“Menu” appears on the display.

BBBB Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Paper Input”, and then press the {{{{Enter #}}}} key.

CCCC Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Tray Priority”, and then press the {{{{Enter #}}}} key.

ZHBS010E

  Menu:

   Paper Input

  Paper Input:

   Tray Priority



Operating Instructions Administrator Reference

132

DDDD Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to select the tray type you want to use.

EEEE Press the {{{{Enter #}}}} key. Wait for two seconds.

“Menu” appears on the panel display.

FFFF Press the {{{{On Line}}}} key.

“Ready” appears on the display.

ZHBS050E

  Ready
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List/Test Print Menu

You can make the following settings from the List/Test Print menu:

• Config. Page

• Menu List

• Color Demo Page

• PS Config. Page

• PCL Config.Page

• Hex Dump

List/Test Print Parameters

Menu Description

Config. Page You can print the current configuration of the printer. See p.134 “Printing a Con-
figuration Page”. 

Menu List You can print the Menu List which shows the function menus of this printer.

Color Demo Page You can print the Color Demo Page.

PS Config. Page You can print a list of  installed PS Fonts.

PCL Config.Page You can print the current configuration of the PCL.

Hex Dump You can print the Hex Dump.
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Printing a Configuration Page

Reference

For more information, see p.137 “Interpreting the Configuration Page”.

AAAA Press the {{{{Menu}}}} key.

“Menu” appears on the panel display.

BBBB Press the {{{{TTTT}}}} or {{{{UUUU}}}} key to display the List/Test Print menu.

ZHBS010E

  Menu:

   List/Test Print
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CCCC Press the {{{{Enter #}}}} key.

The following message appears on the display.

DDDD Press the {{{{Enter #}}}} key.

The following message appears on the display.

After a short time, the configuration page will start printing.

Important

❒ If you cannot print the configuration page, check for an error message appears on the display.

For more information about error messages, see “Troubleshooting”, Maintenance Guide.

ZHBS040E

  List/Test Print:

   Config. Page

  Printing...
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EEEE Press the {{{{On Line}}}} key.

“Ready”appears on the panel display.

ZHBS050E

  Ready

   



Operating Instructions Administrator Reference

137

Interpreting the Configuration Page

System Reference

❖❖❖❖ Printer ID
Displays the serial number assigned to the board by its manufacturer.

❖❖❖❖ Firmware Version

• Firmware
Displays the printer controller firmware version number.

• Engine
Displays the printer engine firmware version number.

• NCS
Shows the version number of the Network Interface Board.

❖❖❖❖ Pages Printed
Shows the total number of pages printed by the printer to date.

❖❖❖❖ Total Memory
Shows the total amount of memory (SDRAM) installed on the printer.

❖❖❖❖ Controller Option
The item(s) appears when the controller option(s) is installed.

❖❖❖❖ Printer Language
Displays the printer language version number.
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❖❖❖❖ Options
Displays the options installed.

Paper Input

Displays the settings made under the Paper Input menu.

Reference

For more information, see p.126 “Paper Input Menu”.

Maintenance

Displays the settings made under the “Maintenance” menu.

Reference

For more information, see p.140 “Maintenance Menu”.

System 

Displays the settings made under the System menu. 

Reference

For more information, see p.153 “System Menu”.
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PCL Menu

Displays the settings made under the PCL Menu. 

Reference

For more information, see p.175 “PCL Menu”.

Host Interface

Displays the settings made under the Host Interface menu. 

When DHCP is active on the network, the actual IP address, subnet mask, and gateway address appear
in parentheses on the configuration page.

Reference

For more information about the Host Interface menu, see p.163 “Host Interface Menu”.

Interface Information

Displays the interface information.

Error Log

Displays the log of printer errors.
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Maintenance Menu

You can make the following settings from the Maintenance menu:

• Color Regist.

• Image Density

• Registration

• PlainPaper Type

• Envelope Type

• Maint. Reset

• HDD Format

• ROM Update

• 4C.Graphic Mode

• WL.LAN Signal

• WL.LAN Defaults

• Print Area

• Key Repeat

• Menu Protect

• Series Prnt.Job
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Maintenance Menu Parameters 

Menu Description

Color Regist. You can adjust the color alignment for each color (black, cyan, magenta, yellow)

Reference

For more information about registration, see “Adjusting the Color 

Registration”, Maintenance Guide.

Image Density ❖❖❖❖ Prt. Test Sheet
You can print the registration test sheet.

❖❖❖❖ Black, Cyan, Magenta, Yellow
You can specify per color the image density in the range of -10 to +10.

❖❖❖❖ Reset→→→→Defaults
This function returns settings to their default values.

Registration ❖❖❖❖ Prt. Test Sheet
You can print the registration test sheet.
Tray 2, Tray 3, Duplex.BackSide

❖❖❖❖ Adjustment
You can select the start position for printing on page.
Horiz.: Tray 2, Horiz.: Tray 3, Horiz.:Dup.Back
-15 to +15 (by 1)
One step is 1/300 inch (0.8 mm)

Note

❒ The registration values are not default.

❒ Only the installed trays appear on the display.
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PlainPaper Type You can select the type of plain paper you wish to use as a default.

❖❖❖❖ Tray 1, Tray 2, Tray 3, Bypass Tray

• Thin

• Normal

• Other (1)

• Other (2)

Note

❒ Default: Normal

❒ Some types or brands of paper may not give uniform print quality. 

With such paper, selecting [Other (1)] or [Other (2)] may help.

Envelope Type You can select the type of envelope you wish to use as a default.

• Envelope Type 1

• Envelope Type 2

Note

❒ Default: Envelope Type 1

❒ Some types or brands of envelope may not give uniform print qual-

ity. With such envelopes, selecting [Envelope Type 1] or [Envelope 

Type 2] may help.

Maint. Reset Maintenance Reset allows the user to reset each internal unit counters such as the 
Transfer Belt and Fusing Unit. These counters can be reset at anytime, but are 
necessary at the time of unit reinstallation.

For more information, see “Replacing Consumables”, Maintenance Guide.

Menu Description
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HDD Format You can format the Printer Hard Disk.

Available when the optional Printer Hard Disk is installed.

Reference

For more information about formatting the Printer Hard Disk, see 

“Printer Hard Disk Type 3000”, Option Setup Guide.

ROM Update This menu is not currently used.

4C.Graphic Mode This setting adjusts how much each color of toner overlaps when printing. If 
characters or lines are blurred, selecting [Text Priority] may make them clearer. 
Select [Photo Priority] for normal use.

Note

❒ Default: Photo Priority

WL.LAN Signal You can check the signal strength when using the wireless LAN. 

Reference

For more information about displaying the signal strength. See 

p.149 “Displaying the Signal Strength”.

WL.LAN Defaults You can reset the wireless LAN settings to the default.

Print Area You can extend the printable area by about 2.5 mm (0.01 inch).

• Normal

• Enlarge Area

Note

❒ Default: Normal

Key Repeat The default setting [On] enables the user to scroll through menu items and set-
tings by holding the key down continuously, the [Off] setting requires the user to 
press the key for each Cursor/Scroll movement.

Menu Description
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*1 While the printer is On Line, press the {{{{Enter #}}}} key, and then press the {{{{Escape}}}} key. Finally, press the
{{{{Menu}}}} key. You can access the Menu Protect, and Series Prnt.Job menu on the panel display.

Menu Protect *1 This procedure lets you protect menu settings against accidental changes. It 
makes it impossible to change menu settings made by normal procedure unless 
you perform the required key operation. In a network environment, protecting 
settings makes changing menu settings a network administrator task.

• Level 1

• Level 2

• Off

Note

❒ Default: Off

❒ While the printer is On Line, press the {{{{Enter #}}}} key, and then press 

the {{{{Escape}}}} key, finally press the {{{{Menu}}}} key. You can access the 

Menu Protect menu on the panel display.

❒ You can protect the Maintenance, System , Host Interface and 

Language menu on Level 1.

❒ You can protect the Paper Input, Maintenance, System , Host In-

terface and Language menu on Level 2.

Series Prnt.Job *1 You can print series of print jobs without time intervals between them when jobs 
are sent from the same computer, PDL, and interface.

Note

❒ Default: On

❒ When the Job Reset key is pressed, all jobs sent to the machine 

will be canceled.

Menu Description
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Changing the Maintenance Menu

Protecting the menus

AAAA Check if the On Line indicator is on. If not, press the {{{{On Line}}}} key to enter the “Ready” con-

dition.

BBBB Press the {{{{Enter #}}}} key, then the {{{{Escape}}}} key, and then the {{{{Menu}}}} key.

“Menu” appears on the display.

ZHBS060E
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CCCC Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display the Maintenance menu, and then press the {{{{Enter #}}}} key.

The following message appears on the display:

DDDD Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Menu Protect”.

EEEE Press the {{{{Enter #}}}} key.

The following message appears on the display:

FFFF Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to select the levels desired, and then press the {{{{Enter #}}}} key. Wait

for two seconds.

“Maintenance” appears on the display.

  Maintenance:

   Color Regist.

  Maintenance:

   Menu Protect

  Menu Protect:

  *Off
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GGGG Press the {{{{On Line}}}} key.

“Ready” appears on the display.

ZHBS050E

  Ready
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Removing Protect

AAAA Check if the On Line indicator is on. If not, press the {{{{On Line}}}} key to enter the “Ready”

condition.

BBBB Press the {{{{Enter #}}}} key, then the {{{{Escape}}}} key, and then the {{{{Menu}}}} key.

“Menu” appears on the display.

CCCC Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display Maintenance menu, and then press the {{{{Enter #}}}} key.

The following message appears on the panel display:

DDDD Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Menu Protect”, and then press the {{{{Enter #}}}} key.

EEEE Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Off”, and then press the {{{{Enter #}}}} key. Wait for two

seconds.

“Maintenance” appears on the display.

FFFF Press the {{{{On Line}}}} key.

“Ready” appears on the panel display.

  Maintenance:

   Color Regist.
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Displaying the Signal Strength

If you need to check the IEEE 802.11b (Wireless LAN) signal, select “WL.LAN Signal” in the Main-
tenance menu.

AAAA Press the {{{{Menu}}}} key.

“Menu” appears on the display.

BBBB Press the {{{{TTTT}}}} or {{{{UUUU}}}} key to display the Maintenance menu.

CCCC Press the {{{{Enter #}}}} key.

The following message appears on the panel display:

DDDD Press the {{{{TTTT}}}} or {{{{UUUU}}}} key to display “WL.LAN Signal”.

  Menu:

   Maintenance

  Maintenance:

   Color Regist.

  Maintenance:

   WL.LAN Signal
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EEEE Press the {{{{Enter #}}}} key.

One of the following messages appears on the panel display:

Note

❒ If “WL.LAN Signal” is not displayed, “IEEE 802.11b” has not been selected for “LAN Type” in

“Network Setup” of the Host Interface menu. Select “IEEE 802.11b” for “LAN Type”, and then

check the “WL.LAN Signal” in the Maintenance menu again.

❒ If “802.11 Ad hoc” or “Ad hoc” in “Comm. Mode” of “IEEE 802.11b” in the Host Interface menu is

selected, you cannot check the signal. Select “Infrastructure”, and then check it again.

❒ Every time you press the {{{{Enter #}}}} key, the signal is updated.

❒ The signal is indicated as “Good” if the signal strength is 76-100%, “Fair” if the strength is 41-

75%, “Poor” if the strength is 21-40%, and “Unavailable” if the strength is 0-20%. If the signal is

unstable or unavailable, remove obstacles or move the printer to a place where the signal can

be received.

❒ Using wireless devices or microwave sources near the printer might affect the signal.

  WL.LAN Signal

  Good       100%

  WL.LAN Signal

  Fair        50%

  WL.LAN Signal

  Poor         30%

  WL.LAN Signal

  Unavailable  18%
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FFFF Press the {{{{Escape}}}} key.

GGGG Press the {{{{On Line}}}} key.

“Ready” appears on the display.

Resetting the IEEE 802.11b (Wireless LAN) Settings

If you need to reset the wireless LAN setting, select “WL.LAN Defaults” in the Maintenance menu.

Note

❒ The five items that can be reset in “IEEE 802.11b” of the Host Interface menu are “Comm. Mode”,

“Channel”, “Trans. Speed”, “ WEP Setting “, and “SSID”.

AAAA Press the {{{{Menu}}}} key.

“Menu” appears on the display.

BBBB Press the {{{{TTTT}}}} or {{{{UUUU}}}} key to display the Maintenance menu.

  Ready

   

  Menu:

   Maintenance
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CCCC Press the {{{{Enter #}}}} key.

The following message appears on the display:

DDDD Press the {{{{TTTT}}}} or {{{{UUUU}}}} key to display “WL.LAN Defaults”.

EEEE Press the {{{{Enter #}}}} key.

FFFF Press the {{{{Enter #}}}} key.

The following message appears on the panel display:

The wireless LAN setting value is reset.

“Ready” appears on the panel display.

  Maintenance:

   Color Regist.

  Maintenance:

   WL.LAN Defaults

  WL.LAN Defaults

  Reset→Defaults

  Defaults reset

  

  Ready
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System  Menu

You can make the following settings from the System  menu:

• MisfeedRecovery

• Prt. Err Report

• Auto Continue

• Memory Overflow

• Copies

• Printer Lang.

• Sub Paper Size

• Page Size

• Duplex

• Energy Saver 1

• E. Saver2 Timer

• Unit of Measure

• Resolution

• B&W Page Detect

• Spool Printing

• Letterhead Mode

• E.Saver2 OnOff
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System  Parameters

Menu Description

MisfeedRecovery You can select whether Misfeed Recovery is enabled. When it is on, printing re-
starts after the misfed paper has been cleared.

• On

• Off

Note

❒ Default: On

Prt. Err Report You can have an error report printed when a printer error or memory error occurs.

• On

• Off

Note

❒ Default: Off
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Auto Continue You can have Auto Continue enabled. When it is on, printing continues after a 
system error occurs.

• Off

• 0 minutes

• 1 minute

• 5 minutes

• 10 minutes

• 15 minutes

Note

❒ Default: Off

❒ When it is on, and certain types of error occur, the current job might 

be canceled, and the machine automatically resumes the next job.

Memory Overflow You can have memory overflow error reports printed.

• Not Print

• Error Report  

Note

❒ Default: Not Print

Copies You can specify how many pages to print.

This setting is disabled if the number of pages to print has been specified with the 
printer driver or a command.

• 1-999

Menu Description
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Printer Lang. You can specify the printer language.

• Auto

• PCL

• PS

Note

❒ Default: Auto Detect

Sub Paper Size You can enable the Sub Paper Size feature. When you select “Auto ”, the printer 
substitutes the paper of a certain size which is to be an alternative if the paper cur-
rently specified is not loaded. When you select “Off”, the printer uses the paper 
in the current specified paper input tray regardless of its size.

• Auto 

• Off

Note

❒ Default: Off

Page Size You can specify the default paper size.

8 1/2 x 14, 8 1/2 x 11, 5 1/2 x 8 1/2, 7 1/4 x 10 1/2, 8 x 13, 8 1/2 x 13, 8 1/4 x 13, 
A4, B5, A5, A6, 16K, 4 1/8 x 9 1/2, 3 7/8 x7 1/2, C5 Env(162x229), C6 
Env(114x162), DL Env(110x220), Custom Size

Note

❒ Default: A4 (297×210) (Metric version) 8 1/2 x 11 (Inch version)

Menu Description



Operating Instructions Administrator Reference

157

Duplex You can select to print on both sides of each page.

• Off

• Short Edge Bind

• Long Edge Bind

Note

❒ Default: Off

❒ This menu appears only if the optional duplex unit is installed.

Energy Saver 1 You can set On/Off for the Energy Save Mode level 1. This is Preheat mode.

• On

• Off

Note

❒ Default: On

❒ When the printer switches to Energy Saver mode, the Power indi-

cator turns off, while the On Line indicator stays on.

E. Saver2 Timer You can set how many minutes the printer waits before switching to Energy Sav-
er mode. Energy Saver mode reduces electric power consumption.

5 minutes, 15 minutes, 30 minutes, 45 minutes, 60 minutes.

Note

❒ Default: 5 minutes

❒ When the printer switches to Energy Saver mode, the Power indi-

cator turns off, while the On Line indicator stays on and “Energy 

Save Mode” is displayed on the panel display.

Menu Description
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Unit of Measure You can select “mm” or “inch” for the custom paper size.

Note

❒ Default: mm (Metric version), inch (Inch version)

• Metric version: mm

• Inch version: inch 

Resolution You can set the print resolution in dots per inch.

❖❖❖❖ PCL
300 x 300 dpi, 600 x 600 dpi

❖❖❖❖ PS3
600 x 600 dpi, 1200 x 1200 dpi, 1200 x 600 dpi

Note

❒ Default: PCL 600 x 600 dpi, PS3 600 x 600 dpi

B&W Page Detect You can have the Black & White Page Detect feature enabled.

• On

• Off

Note

❒ Default: On

Menu Description
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*1 While the printer is On Line, press the {{{{Enter #}}}} key, and then press the {{{{Escape}}}} key. Finally, press the
{{{{Menu}}}} key. You can access the Letterhead Mode, E.Saver2 OnOff menu on the display.

Spool Printing You can select to enable spool printing. Spool Printing allows print jobs sent 
from a computer to be temporarily stored and printed after they have been sent.

• On

• Off

Note

❒ Default: Off

❒ Spooling stores the print job sent by a computer temporarily in the 

printer, transfers the print job, and then prints it.

❒ This menu appears Only when the optional Printer Hard Disk is in-

stalled.

Letterhead Mode *1 You can select the letterhead printing mode.

• Off

• Auto Detect

Note

❒ Default: Off

E.Saver2 OnOff *1 You can set On/Off for the Energy Save Mode level 2.

• On

• Off

Note

❒ Default: On

Menu Description
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Changing the System  Menu

The following example describes how to change the settings for “E. Saver2 Timer”.

AAAA Press {{{{Menu}}}}.

“Menu” appears on the display.

BBBB Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “System ”.

ZHBS010E

  Menu:

   System  
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CCCC Press {{{{Enter #}}}}.

The following message appears on the display:

DDDD Press {{{{UUUU}}}} or {{{{TTTT}}}} to display “E. Saver2 Timer”, and then press {{{{Enter #}}}}.

ZHBS040E

  System :

   MisfeedRecovery

  System :

  E. Saver2 Timer
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EEEE Press {{{{UUUU}}}} or {{{{TTTT}}}} to select how many minutes the printer waits before switching to Energy

Saver mode.

The following message appears on the display:

FFFF Press {{{{Enter #}}}}. Wait for two seconds.

“Menu” appears on the display.

GGGG Press {{{{On Line}}}}.

“Ready” appears on the display.

  E. Saver2 Timer

  *30 minutes

ZHBS050E

  Ready
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Host Interface Menu

You can make the following settings from the Host Interface menu:

• I/O Buffer

• I/O Timeout

• Network Setup

• IEEE 1394 Setup

• IEEE 802.11b

• USB Setting

Reference

For more information about “Network Setup”, see “Configuring the printer for the Network”, Quick

Installation Guide.
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Host Interface Parameters 

Menu Description

I/O Buffer You can set the size of the I/O Buffer. Normally it is not necessary to change this 
setting.

128 KB, 256 KB, 512 KB

Note

❒ Default: 128 KB

I/O Timeout You can set how many seconds the printer should wait before ending a print job. 
If data from another port often appears in the middle of the print job, you should 
increase the timeout value.

10 seconds, 15 seconds, 20 seconds, 25 seconds, 60 seconds

Note

❒ Default: 15 seconds
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Network Setup ❖❖❖❖ DHCP
You can set how the Network Interface Board acquires TCP/IP settings.

Note

❒ Default: On

Reference

See “Configuring the printer for the Network”,Quick Installation 

Guide.

❖❖❖❖ IP Address
You can set the IP address.

Limitation

❒ When DHCP is On, its setting cannot be changed. If you want 

to change the setting, Make the setting for DHCP Off. Consult 

the network administrator for information about how to make 

the setting for the network.

Note

❒ Default: All zero

Reference

See “Configuring the printer for the Network”,Quick Installation 

Guide.

Menu Description
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Network Setup ❖❖❖❖ Subnet Mask
You can set the Subnet mask.

Limitation

❒ When DHCP is On, its setting cannot be changed. If you want 

to change the setting, Make the setting for DHCP Off. Consult 

the network administrator for information about how to make 

the setting for the network.

Note

❒ Default: All zero

Reference

See “Configuring the printer for the Network”,Quick Installation 

Guide.

❖❖❖❖ Gateway Address
You can set the gateway address.

Limitation

❒ When DHCP is On, its setting cannot be changed. If you want 

to change the setting, Make the setting for DHCP Off. Consult 

the network administrator for information about how to make 

the setting for the network.

Note

❒ Default: All zero

Reference

See “Configuring the printer for the Network”,Quick Installation 

Guide.

Menu Description
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Network Setup ❖❖❖❖ Frame Type (NW)
You can set the Frame type for NetWare.

Note

❒ Default: Auto 

❖❖❖❖ Active Protocol
You can set the active protocol.
TCP/IP, NetWare, NetBEUI, AppleTalk

Note

❒ Default: All Active

Menu Description
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Network Setup ❖❖❖❖ Ethernet 
You can select the speed of the network that the printer is connected to.
Auto , 10 Mbps, 100 Mbps

Note

❒ Default: Auto 

Reference

See “Configuring the printer for the Network”,Quick Installation 

Guide.

❖❖❖❖ LAN Type
You can select Ethernet or IEEE 802.11b for the LAN Type.

Note

❒ Default: Ethernet 

❒ Appears Only when the optional 802.11b Interface Unit is in-

stalled.

Reference

For more information about Network Setup, see “Configuring 

the printer for the Network”,Quick Installation Guide.

Menu Description
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IEEE 1394 Setup *1 You can make settings for using IEEE 1394. This menu appears only when the 
optional IEEE 1394 board is installed. 

❖❖❖❖ IP Address1394
You can set the IP address for IEEE 1394 (IP over 1394).

Note

❒ Default: All zero

❖❖❖❖ Subnet Mask1394
You can set the Subnet Mask for IEEE 1394 (IP over 1394).

Note

❒ Default: All zero

❖❖❖❖ IP over 1394
You can activate IP over 1394.

Note

❒ Default: Active

❖❖❖❖ SCSI print
You can activate SCSI print.

Note

❒ Default: Active

❖❖❖❖ Bidi-SCSI print
You can activate bidirectional transmission for SCSI print.

Note

❒ Default: On

Menu Description
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IEEE 802.11b *2 You can make settings for using the wireless LAN. This menu appears only when 
the optional 802.11b Interface Unit is installed.

❖❖❖❖ Comm. Mode
You can set the transmission mode for IEEE 802.11b.

Note

❒ Default: 802.11 Ad hoc

❖❖❖❖ Channel
The selectable channels are 1-11 (Inch version) and 1-13 (Metric version).

Note

❒ Default: 11

❖❖❖❖ Trans. Speed
You can set the transmission speed for IEEE 802.11b.

Note

❒ Default: Auto 

Menu Description
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*1 Appears only when the optional 1394 Interface Unit is installed.
*2 Appears only when the optional 802.11b Interface Unit is installed.

IEEE 802.11b *2 ❖❖❖❖ SSID
You can set for SSID in Infrastructure mode and 802.11 Ad hoc mode.

Limitation

❒ Select "¥" if you want to enter "/" in the SSID. Also, "¥" appears 

when printing the configuration page, read it as "/".

Note

❒ The characters that can be used are ASCII 0x20-0x7e (32 

bytes).

❒ A SSID value is set automatically to the nearest access point if 

the setting has not been made.

❒ If the setting has not been made for 802.11 Ad hoc mode, the 

same value as for Infrastructure mode or an "ASSID" value is 

set automatically.

❖❖❖❖ WEP Setting
You can set the code for IEEE 802.11b.

Note

❒ Default: Not Active

❒ With a 64-bit WEP, you can use 10 digit hexadecimal. With a 

128-bit WEP, you can use 26 digit hexadecimal.

USB Setting You can set the transmission speed for USB.

Note

❒ Default: Auto 

Menu Description
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Changing the Host Interface Menu

The following example describes how to change the setting for “I/O Timeout”:

AAAA Press the {{{{Menu}}}} key.

“Menu” appears on the display.

BBBB Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display the Host Interface menu.

ZHBS010E

  Menu:

   Host Interface
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CCCC Press the {{{{Enter #}}}} key.

The following message appears on the display:

DDDD Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “I/O Timeout”.

EEEE Press the {{{{Enter #}}}} key.

The following message appears on the display:

ZHBS040E

  Host Interface:

   I/O Buffer

  Host Interface:

   I/O Timeout

  I/O Timeout:

  *15 seconds
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FFFF Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to select how many minutes the printer waits before ending a print

job.

GGGG Press the {{{{Enter #}}}} key. Wait for two seconds.

“Host Interface” appears on the display.

HHHH Press the {{{{On Line}}}} key.

“Ready” appears on the display.

ZHBS050E

  Ready
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PCL Menu

You can make the following settings from the “PCL Menu”:

• Orientation

• Form Lines

• Font Source

• Font Number

• Point Size

• Font Pitch

• Symbol Set

• Ext. A4 Width

• Append CR to LF

PCL Parameters

Menu Description

Orientation You can set the page orientation.

• Portrait

• Landscape

Note

❒ Default: Portrait
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Form Lines You can set the number of lines per page.

5-128

Note

❒ Default: 64(Metric version), 60 (Inch version)

Font Source You can set the location of the default font.

• Resident

• RAM

• HDD

Note

❒ Default: Resident

❒ When you select “RAM”, you can select only fonts downloaded to 

the printer RAM.

Font Number You can set the ID of the default font you want to use.

• 0 to 50 (for Resident)

• 0 to 44 (for RAM)

• 1 to 32767 (for HDD)

Note

❒ Default: 0

Point Size You can set the point size you want to use for the default font.

4 to 999.75 by 0.25

Note

❒ Default: 12.00 points

❒ This setting is effective only for a variable-space font.
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Font Pitch You can set the number of characters per inch you want to use for the default font.

0.44 to 99.99 by 0.01

Note

❒ Default: 10.00 pitch

❒ This setting is effective only for a fixed-space font.

Symbol Set You can specify the set of print characters for the default font. The available op-
tions are as follows:

Roman-8, ISO L1, ISO L2, ISO L5, PC-8, PC-8 D/N, PC-850, PC-852, PC8-TK, 
Win L1, Win L2, Win L5, Desktop, PS Text, VN Intl, VN US, MS Publ, Math-
8, PS Math, VN Math, Pifont, Legal, ISO 4, ISO 6, ISO 11, ISO 15, ISO 17, ISO 
21, ISO 60, ISO 69, Win 3.0

Note

❒ Default: Roman-8

Ext. A4 Width You can extend the width of the printable area for an A4 sheet leaving a narrow 
margin on the sides.

• On

• Off

Note

❒ Default: Off

Append CR to LF By adding a CR code to each LF code, you can print text data clearly.

• On

• Off

Note

❒ Default: Off
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Changing the PCL Menu

The following example describes how to change the setting for “Orientation”:

AAAA Press the {{{{Menu}}}} key.

“Menu” appears on the display.

ZHBS010E
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BBBB Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “PCL Menu”, and then press the {{{{Enter #}}}} key.

The following message appears on the display:

CCCC Press the {{{{Enter #}}}} key.

DDDD Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to select the orientation desired, and then press the {{{{Enter #}}}} key.

Wait for two seconds.

“PCL Menu” appears on the panel display.

ZHBS040E

  PCL Menu:

   Orientation

  Orientation:

  *Portrait
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EEEE Press the {{{{On Line}}}} key.

“Ready” appears on the display.

ZHBS050E

  Ready
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Language Menu

You can select a languages to use. Available languages are:

English, German, French, Italian, Spanish, Dutch, Swedish, Norwegian, Danish, Finnish, Portuguese,
Czech, Polish and Hungarian.

Note

❒ Default: English

Changing the Language Menu

You can change the language by the following procedures:

AAAA Press the {{{{Menu}}}} key.

“Menu” appears on the display.

ZHBS010E
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BBBB Press the {{{{UUUU}}}} or {{{{TTTT}}}} key to display “Language”.

CCCC Press the {{{{Enter #}}}} key.

The following message appears on the display:

DDDD Press the {{{{UUUU}}}} or {{{{TTTT}}}} key until the language you want to select appears on the panel display.

EEEE Press the {{{{Enter #}}}} key. Wait for two seconds.

“Menu” appears on the display.

  Menu:

   Language

ZHBS040E

  Language:

  *English
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FFFF Press the {{{{On Line}}}} key.

“Ready” appears on the display.

ZHBS050E

  Ready
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8. Appendix

SNMP

The Network Interface Board functions as a SNMP (Simple Network Management Protocol) agent us-
ing the UDP and IPX protocols. Using the SNMP manager, you can get information about the printer.

The factory default community names are "public" and "admin". You can get MIB information using
these community names.

Reference

You can configure SNMP from the command line using telnet. See p.197 “SNMP”.

You can configure SNMP from SmartDeviceMonitor for Admin using the NIB Setup Tool. See Help

for SmartDeviceMonitor for Admin.

You can configure SNMP from your Web browser. See Help on the CD-ROM.

Limitation

❒ The optional 1394 Interface Unit supports TCP/IP only.

❒ The kinds of supported MIBs differ depending on the printer.

❖❖❖❖ Supported MIBs

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB
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Spool Printing

With Spool Printing, the whole data of a print job is saved in the Printer Hard Disk before printing. To
use this function, set it from the menu. See p.153 “System Menu”.

Important

❒ Do not turn off the printer or the computer when a print job is being spooled and the Data In indicator

is blinking. If you do, the print job will remain in the Printer Hard Disk and be printed when the printer

is turned on.

Limitation

❒ Spool Printing does not appear unless the optional Printer Hard Disk is installed.

❒ Data that has been received in the protocol other than LPD or IPP cannot be spooled.

❒ Up to 50 jobs (approximately 1000 MB) can be spooled at a time.

❒ When Spool Printing is on, the size of a single print job cannot exceed 500 MB.

❒ When sending spooled print jobs from more than one computer at the same time, up to five LPR

jobs and one IPP job can be spooled. Jobs exceeding the maximum number cannot be spooled.

Wait until the number of spooled print jobs falls below the maximum.

Note

❒ When "On" is selected, the first print will take time.

Note

❒ Spool jobs stored in the machine can be viewed or deleted using a Web browser. 
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----Viewing/Deleting spool jobs in a Web browser

Launch the Web browser and enter the machine's IP address in the address bar. This displays the top
page.

Example : 

http://192.168.0.10

(In this example, the IP address of the machine is 192.168.0.10)

Click “Admin Info”, and then “Spool Printing Job List (Printer)” to display the spool jobs. To delete,
check the box next to the name of the file you want to delete. Enter the password *1 , and then click
[Delete]. For more information, see p.111 “Configuring the Network Interface Board Settings”.
*1 The default password is “password”.

----Setting Spool Printing

Spool Printing can be set using telnet or a Web browser.

• Using a Web browser
Click ”Configuration”, and then “General”. Set “Spool Printing”to “Enable”.

• Using telnet
Enter “spoolsw spool on” to set Spool Printing.

Reference

For more information about how to set up the spool printing, see the Help file.
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board using telnet.

Note

❒ You should specify a password so that only the network administrator, or a person having network

administrator privileges, can use remote maintenance. 

Using telnet

The following is a sample procedure in using telnet.

Limitation

❒ Only one person at a time can be logged on to do remote maintenance.

AAAA Use the IP address or the host name of the printer to start telnet.

% telnet IP_address

Note

❒ In order to use the host name instead of the IP address, you must write it to the "/etc/hosts" file.

BBBB Type the password.

Note

❒ The factory default is "password".

CCCC Type a command.

Reference

 For more information about telnet commands, see p.189 “Commands List”.
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DDDD Exit telnet.

msh> logout

When the configuration is changed, a confirmation message requests whether or not the changes
should be saved.

EEEE Type "yes" to save the changes, and then press {{{{Enter}}}}.

If you do not want to save the changes, type "no", and then press {{{{Enter}}}}. If you want to make ad-
ditional changes, type "return" at the command line, and then press {{{{Enter}}}}.

Note

❒ If the "Can not write NVRAM information" message appears, the changes are not saved. Repeat

the steps above.

❒ The Network Interface Board is reset automatically when the settings are changed.

❒ When the Network Interface Board is reset, the active print job which has already been sent to

the printer will finish printing. However, jobs that have not been sent yet will be canceled.
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Commands List

This is a list of commands that can be used via remote maintenance.

Note

❒ Type "help" to see a list of commands that can be used.

msh> help

❒ Type "help command_name" to display information about the syntax of that command.

msh> help command_name

TCP/IP address

Use the ifconfig command to configure TCP/IP (IP address, subnet mask, broadcast address, default
gateway address) for the machine.

❖❖❖❖ Reference
msh> ifconfig

❖❖❖❖ Configuration
msh> ifconfig interface_name parameter address

Interface name Interface to be configured

ether

naf0

Ethernet Interface *1 

ip1394 *2 

fwip0 *2 

IEEE 1394 Interface
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*1 If you did not enter the interface name, it will be automatically set to the Ethernet interface.
*2 Available when the optional 1394 Interface Unit is installed. 
*3 You can specify an interface when installing the optional 802.11b Interface Unit.

❖❖❖❖ Changing the Interface
You can specify either the LAN interface or IEEE 802.11b interface when using the optional
802.11b Interface Unit.

msh> ifconfig interface up

Note

❒ You cannot specify the IEEE 1394 interface.

wlan *3 

wi0 *3 

IEEE 802.11b Interface

Parameter Meaning

(no parameter) IP address

netmask subnet mask

broadcast broadcast address

Interface name Interface to be configured
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The following is an example for configuring an IP address of 192.168.15.16 on Ethernet interface.

msh> ifconfig ether 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0 on Ethernet interface.

msh> ifconfig ether netmask 255.255.255.0

Note

❒ This affects the configuration of the Network Interface Board of the IP address that is used.

❒ The TCP/IP setting is the same as that for the LAN interface and IEEE 802.11b interface.

❒ To type an address using hexadecimal, prefix it by “0x”.

----Address

❖❖❖❖ Subnet Mask
A number used to mathematically “mask” or hide the IP address on the network by eliminating those
parts of the address that are alike for all the machines on the network.

Note

❒ To get the above addresses, contact your network administrator.

❒ The subnet mask is the same as that for the LAN interface and IEEE 802.11b interface.

❒ When installing the optional 1394 Interface Unit, set the subnet so that it does not overlap with the

LAN interface or the IEEE 1394 interface.
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Access Control

Use the access command to view and configure access control. You can also specify two or more access
ranges.

❖❖❖❖ Reference

msh> access

❖❖❖❖ Configuration
msh> access ✩ range start-address end-address

• ✩ represents a target number between 1 and 5. (Up to five access ranges can be registered and
selected.)

Example: To specify accessible IP addresses between 192.168.0.10 and 192.168.0.20:
msh> access 1 range 192.168.0.10 192.168.0.20

Note

❒ The access range restricts the workstations from which printing is possible by means of an ad-

dress. If you do not need to restrict printing, make the setting “0.0.0.0”.

❒ The entry is invalid if the start address is greater than the end address.

❒ Up to five access ranges can be specified. The entry is invalid if the target number is omitted.

❒ When using a Web browser, telnet or SmartDeviceMonitor for Client/Admin, you can use an IP

address that has not been restricted by access control.

❖❖❖❖ Access Control Initialization 
msh> access flush

Note

❒ This restores the factory-default settings so that all access ranges become "0.0.0.0".
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DHCP

Use the set command to configure the boot method.

msh> set parameter {on|off}|{on|off}

"on" means active and "off" means inactive.

Note

❒ The default is "on".

❒ When you use DHCP, the server also needs to be configured.

❒ DHCP takes precedence over all other settings.

Parameter Meaning

dhcp DHCP (Dynamic Host Configuration Pro-
tocol)
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Protocol

Use the set command to allow/prevent remote access for each protocol.

msh> set protocol {up | down}|{up | down}

*1 Available when the optional 1394 Interface Unit is installed.

Note

❒ If you prohibit remote access using TCP/IP and then log out, you cannot use remote access. If this

was a mistake, you can use the control panel to allow access by TCP/IP.

❒ When you prevent access via TCP/IP, you are also prevented from using ip1394, lpr, ftp, rsh, diprint,

web, snmp and ipp.

Protocol

appletalk 

tcpip

netware

netbeui

scsiprint *1 

ip1394 *1 

lpr

ftp

rsh

diprint

 web

 snmp

 ipp

“up” means active and “down” means inac-
tive.
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Printer status

The following commands can be used to get information about the current status of the printer.

msh> command

Note

❒ More information about any print job is displayed when the ID number is added after the prnlog com-

mand.

Reference

For more information about the meaning of the data returned with these commands, see p.220 “Un-

derstanding the Displayed Information”.

Command Information that is displayed

status Status of printer.

Information about the print jobs.

info Information about the paper tray, output tray, and 
printer language.

prnlog [ID] Lists the last 16 print jobs.
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Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration settings.

msh> show [-p]

Note

❒ Add "-p" to the show command to have information displayed on screen at one time.

Reference

For more information about the meaning of the data returned with this command, see p.222 “Con-

figuring the Network Interface Board”.

System log information

Use the syslog command to display information stored in the printer's system log. 

msh> syslog

Reference

For more information about the displayed information, see p.227 “System Log Information”.
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SNMP

Use the snmp command to display and edit SNMP configuration settings such as the community name.

Note

❒ You can configure from ten SNMP access settings numbered 1–10.

❒ Default access settings 1 and 2 are as follows:

❖❖❖❖ Display
Shows the SNMP information and available protocols.

msh> snmp ?
msh> snmp [-p] [registered_number]

Note

❒ If the -p option is added, you can view the settings one by one.

❒ Omitting the number displays all access settings.

❖❖❖❖ Community name configuration
You can set the community name of the Network Interface Board.

msh> snmp number name community_name

Note

❒ The community name must be within 15 characters.

Number 1 2

Community name public admin

IP address 0.0.0.0 0.0.0.0

Access type read-only

trap off

read-write

trap off
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❖❖❖❖ Access type configuration
You can select the access type from those listed below.
msh> snmp number type access_type

❖❖❖❖ Protocol configuration
You should use the following command to set the protocols to active or inactive. If you set a protocol
to inactive, all access settings set to use that protocol are disabled.

msh> snmp {ip | ipx} {on | off}|{ip | ipx} {on | off}|{ip | ipx}
{on | off}

•  "on" means active and "off" means inactive

To change the protocol of access settings, use the following command. However, if you disabled a
protocol with the above command, making it active here will have no effect.

msh> snmp number active {ip | ipx} {on | off}|{ip | ipx} {on |
off}|{ip | ipx} {on | off}

Access type Type of access which is permitted

read Read only

write Read and write

trap User is notified of trap messages.

no All access is denied.
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❖❖❖❖ Access configuration
You can configure an address of a host depending on the protocols used. 
The Network Interface Board accepts requests only from hosts having addresses with access types
of "read-only" or "read-write". Type "0" to have Network Interface Board accept requests from any
host without requiring a specific type of access.

Command syntax:
msh> snmp number {ip | ipx}|{ip | ipx} address

Note

❒ To specify the TCP/IP protocol, type ip followed by a space, and then the IP address.

❒ To specify the IPX/SPX protocol, type ipx followed by a space and then the IPX address followed

by a decimal and then the MAC address of the Network Interface Board.

The following is an example of how to configure registration number 3 with the IP address
192.168.15.16.
msh> snmp 3 ip 192.168.15.16
The following is an example of how to configure registration number 3 with the IPX address
7390A448, and the MAC address 00:00:74:62:5C:65.
msh> snmp 3 ipx 7390A448:000074625C65
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IPP

Use the ipp command to configure the IPP settings.

❖❖❖❖ Viewing setting
The following command displays the current IPP settings.

msh> ipp
Example output:

timeout=900(sec)
auth basic

• The "timeout" setting specifies how many seconds the computer keeps trying to access the net-
work printer to send print jobs when no connection could be made.

• The "auth" setting indicates the user authorization mode.

❖❖❖❖ IPP timeout configuration 
Specifies how many seconds to wait before canceling a print job if it has been interrupted for some
reason. The range of time can be changed between 30 to 65535 seconds.

msh> ipp timeout {30 -65535}

❖❖❖❖ IPP user authorization configuration
Use the IPP user authorization to restrict users to print with IPP. The factory default is "off" .

msh> ipp auth {basic|digest|off}|{basic|digest|off}|{basic|di-
gest|off}

• The setting of user authorization are "basic" and "digest".

• Use "off" to remove a user's authorization.
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Note

❒ If you select "basic" or "digest", see next section "Configuring IPP user authorization" for more

information about how to configure the user name.

❖❖❖❖ Configuring IPP user authorization
Use the following command:

msh> ipp user
The following message appears.

msh> Input user number (1 to 10):
Type the number, user name and password.

msh> IPP user name:user1 msh> IPP password:*******
After configuring the settings, the following message appears.

User configuration changed.

SPRINT

To make setting for IEEE 1394 (SCSI print), use the sprint command.

❖❖❖❖ View settings
The IEEE 1394 (SCSI print) settings are displayed.

msh> sprint

❖❖❖❖ Bidirectional configuration for the IEEE 1394 (SCSI print)
Use this setting to configure whether the IEEE 1394 (SCSI print) is bidirectional.
The factory default is "on".

msh> sprint bidi [on/off]
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Direct Printing Port

The direct printing port allows printing directly from a computer, connected to the network, to the print-
er.

Use the diprint command to change the direct printing port settings.

❖❖❖❖ View settings
The following command displays the current direct printing port settings.

msh> diprint
Example output:

port 9100
timeout=300(sec)
bidirect off

• The “Port” specifies the port number of the direct printing port.

• The “bidirect” setting indicates whether the direct printing port is bidirectional.

❖❖❖❖ Setting timeout
You can specify the timeout interval to use when receiving data from the network.

msh> diprint [0~65535]

Note

❒ The factory default is 300 seconds.

❒ If 0 is set, timeout is disabled.

❖❖❖❖ Bidirectional configuration for the direct printing port
Use this setting to configure whether the direct printing port is bidirectional.
The factory default is “off”.

msh> diprint bidirect {on|off}
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SMB

Use the smb command to configure or delete the computer name or workgroup name for NetBEUI.

msh >smb parameter

Parameter Settings

smb comp Your computer name consisting of up to 47 characters

smb group Workgroup name consisting of up to 15 characters

smb comment Comment consisting of up to 31 characters

smb clear comp Clears complete name

smb clear group Clears Workgroup name

smb clear comment Clears comment
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ROUTE

Use the route command to control the routing table.

This command allows you to configure and display routing information. You can change the network
configuration from a remote computer using this command.

Note

❒ The maximum number of routing tables are 16.

*1 IP address

Parameter Topics of setting

route add {host | net} destination 
gateway|route add {host | net} des-
tination gateway

Adds a host/network route to "destination", and a gateway address to "gateway" 
in the table. Host becomes the default setting.

route delete {host | net} destina-
tion|route delete {host | net} desti-
nation

Deletes a host/network route from the table. Host becomes the default setting.

route get {destination} Displays only route information corresponding to a specified destination. When 
the destination is unspecified, all routing information is displayed.

route active {host | net} destina-
tion|route active {host | net} desti-

nation *1  on/off

You can turn the specified destination on or off. Host becomes the default set-
ting.

route add default gateway *1 You can set the default gateway address.

route flush Deletes all routing information.



Operating Instructions Administrator Reference

205

SLP

Use this command to configure SLP settings.

You can search the NetWare server using SLP in the PureIP environment of NetWare 5. Using the slp
command, you can configure the value of TTL which can be used by SLP multi-cast-packet.

Note

❒ The default value of TTL is "1". A search is executed only within a local segment. If the router does

not support multi-cast, the settings are not available even if the TTL value is increased.

❒ The acceptable TTL value is 1 - 255.

msh> slp ttl {1 -255}

Setting IEEE 802.11b

To make setting for IEEE 802.11b, use the wiconfig command.

Limitation

❒ You can make settings when installing the optional 802.11b Interface Unit.

❖❖❖❖ View settings
The following command displays the current IEEE 802.11b settings.

msh> wiconfig
The IEEE 802.11b card information is displayed.

msh> wiconfig cardinfo

Note

❒ If the IEEE 802.11b interface is not working correctly, the IEEE 802.11b card information is not

displayed.
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❖❖❖❖ Configuration

msh> wiconfig parameter

Parameter Value to be configured

mode [ap|adhoc|802.11adhoc] You can set infrastructure mode (ap) , 802.11 ad hoc 
mode(802.11adhoc) or ad hoc mode (adhoc).

The default is ad hoc mode.

ssid ID value You can set for SSID in infrastructure mode.

The characters that can be used are ASCII 0x20-0x7e 
(32 bytes).

A SSID value is set automatically to the nearest access 
point if the setting has not been made.

If the setting has not been made for ad hoc mode, the 
same value as for infrastructure mode or an "ASSID" 
value is set automatically if the setting has not been 
made.

channel frequency channel no. You can set the channel.

You can specify from following channel.

• Metric Version :1-13

• Inch Version :1-11

Set the same channel for all the machines you are using.

enc [on|off] You can enable or disable the WEP function. To enable 
the WEP function, specify [on]; to disable it, specify 
[off].

To start the WEP function, enter the correct WEP key.
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key [key value] With a 64-bit WEP, you can use 10 digit hexadecimal. 
With a 128-bit WEP, you can use 26 digit hexadecimal.

To use this function, set the same WEP key for all the 
ports that transmit to each other.

auth [open|shared] You can set the authorized mode when using WEP. The 
specified value and the authorized mode are as follows:

open: Open system authorized (default)

shared: Shared key authorized

rate [auto|11m|5.5m|2m|1m] You can set the IEEE 802.11b transmitting speed.

The transmitting speed you specify here is the speed at 
which data is sent. You can receive data at any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m: 2 Mbps fixed

1m: 1 Mbps fixed

Parameter Value to be configured
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WINS

Use the wins command to configure the WINS server settings

For more information about WINS server settings, see p.242 “Configuring a WINS Server”.

❖❖❖❖ Configuration
Use the set command to make WINS active or inactive.

msh> set wins {on|off}|msh> set wins {on|off}

• "on" means active and "off" means inactive.

❖❖❖❖ Viewing setting
The following command displays the WINS server IP address.

msh> wins
Example out put:

wins: primary server 0.0.0.0  secondary server 0.0.0.0

Note

❒ If DHCP is used to start from the network, the current WINS server address is displayed. This

address, however, is not displayed if DHCP is not used.

❒ If the IP address obtained from DHCP differs from the WINS IP address, the DHCP address is

the valid address.

❖❖❖❖ Address configuration
Use this command to configure a WINS server IP address.

msh> wins {primary|secondary} IP_address

Note

❒ Use the "primary" to configure a primary WINS server IP address.

❒ Use the "secondary" to configure a secondary WINS server IP address.
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AutoNet

Use the set command to configure Autonet.

Note

❒ For more information about Autonet, see p.241 “Using AutoNet”.

msh>set autonet {on|off}|msh>set autonet {on|off}

Select "on" to activate Autonet, and "off" to deactivate it.

Changing the Host Name

Use the hostname command to change the printer name.

msh> hostname [interface_name ] printer_name

*1 If you did not enter the interface name, it will be automatically set to the Ethernet interface.
*2 If you install the optional 802.11b Interface Unit, you can set the command.
*3 If you install the optional 1394 Interface Unit, you can set the command.

Note

❒ Enter the printer name using up to 47 characters.

❒ You cannot use a printer name starting with RNP or rnp.

❒ The Ethernet interface and IEEE 802.11b interface will have the same printer name.

interface name Interface to be configured

ether Ethernet interface *1 

wlan  *2 IEEE 802.11b interface

ip1394 *3 IEEE 1394 interface
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SNTP

The printer clock can be synchronized with a NTP server clock using the Simple Network Time Proto-
col (SNTP). To change the SNTP settings, use the sntp command.

Limitation

❒ SNTP supports the NTP servers running xnptd V3 and V4.

❖❖❖❖ Reference
msh> sntp

❖❖❖❖ NTP Server Address Configuration
You can specify the IP address of the NTP server.
msh> sntp server IP_address

❖❖❖❖ Interval Configuration
You can specify the interval at which the printer synchronizes with the operator-specified NTP serv-
er.
msh> sntp interval polling_time

Note

❒ The factory default setting is 3600 seconds.

❒ You can set the interval from 16 to 16384 seconds.

❒ If you set 0, the printer synchronizes with the NTP server only when you turn the printer on. After

that, the printer does not synchronize with the NTP server.
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❖❖❖❖ Time-zone Configuration
You can specify the time difference between the printer clock and the NTP server clock.

msh> sntp timezone +/-hour_time
Example: To set the time-zone difference to +8 hours:

msh> sntp timezone +08:00

Note

❒ The time is in 24-hour notation.



Operating Instructions Administrator Reference

212

Changing the Password

Use the passwd command to change the remote maintenance password.

Important

❒ Be sure not to forget or lose the password.

Note

❒ The default factory password is "password".

AAAA Type "passwd".

msh> passwd

BBBB Type the current password.

Old password:

CCCC Type the new password.

New password:

Note

❒ The password must consist of 3 to 8 alphanumeric characters and symbols. Upper and lower

case characters are considered unique. For example, R is different from r.

❒ The password is the same as that used in the configuration of the Network Interface Board using

a Web browse and that used in the NIB Setup Tool. If you change a password from telnet, other

passwords are also changed.

DDDD Type the new password once again.

Retype new password:
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Getting Printer Information over the Network

Printer current status

You can check the printer's status using the telnet command.

❖❖❖❖ telnet
Use the status command.

Messages Description

Add Toner: Cyan The toner cartridge is empty.

Add Toner: Magenta The toner cartridge is empty.

Add Toner: Yellow The toner cartridge is empty.

Calibrating... The printer is calibrating or the photoconductor unit is being supplied.

Color Regist Error The color registration error has occurred.

Energy Save Mode The printer is in Energy Saver Mode.

Hardware Problem Black PCU The photoconductor unit is not set correctly.

Hardware Problem Bypass Tray An error has occurred in the Bypass Tray.

Hardware Problem Color PCU The photoconductor unit is not set correctly.

Hardware Problem DIMM An error has occurred in the DIMM.

Hardware Problem Ethernet An error has occurred in the Ethernet interface.

Hardware Problem HDD An error has occurred in the optional Printer Hard Disk.

Hardware Problem IEEE1394 An error has occurred in the IEEE 1394 interface.

Hardware Problem NV-RAM An error has occurred in the optional Account Enhance Unit.
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Hardware Problem Option RAM An error has occurred in the optional Memory Unit.

Hardware Problem Parallel I/F An error has occurred in the parallel interface.

Hardware Problem USB An error has occurred in the USB interface.

Hardware Problem Wireless Board An error has occurred in the IEEE 802.11b (Wireless LAN) interface.

Hardware Problem Wireless Card An error has occurred in the IEEE 802.11b (Wireless LAN) card.

Hex Dump Mode The printer is in Hex Dump Mode.

Offline The printer is offline and cannot print data.

Please Wait The printer is initializing the development unit.

The printer is initializing HDD.

Processing... Print data is being processed.

Ready Printing is available.

Replace Black PCU It is time to replace the photoconductor unit.

Replace Color PCU It is time to replace the photoconductor unit.

Replace Fusing Unit It is time to replace the fusing unit.

Resetting Job... Job is being reset.

Toner is Almost Empty: Black The toner cartridge is almost empty.

Toner is Almost Empty: Cyan The toner cartridge is almost empty.

Toner is Almost Empty: Magenta The toner cartridge is almost empty.

Toner is Almost Empty: Yellow The toner cartridge is almost empty.

Waiting... The printer is waiting for the next data to print.

Messages Description
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Warming Up... The printer is warming up.

Waste Toner is Almost Full The waste toner is full.

Messages Description
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Printer configuration

You can check the printer configuration using telnet.

❖❖❖❖ telnet
Use the info command.

Note

❒ "*" (asterisk) is displayed with the current setting.

❒ Regarding *1 - *5, see the following table.

Item Description

Input Tray

 No.

 Name

 PaperSize

 Status

ID number of the paper tray

Name of the paper tray*1

Paper size loaded in the paper tray*2

Current status of the paper tray*3

Output Tray

 No.

 Name

 Status

ID number of the output tray

Name of the output tray*4

Current status of the output tray*5

Printer Language

 No.

 Name

 Version

ID number of the printer language used by the printer

Name of the printer language used in the printer

Version of the printer language
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❖❖❖❖ *1 Input Tray: Name

❖❖❖❖ *2 Input Tray: PaperSize

Name Description

Tray X Name of installed paper tray. (X is the number of tray.)

Bypass Tray Bypass Tray

Paper Size Description

A4 (210 × 297 mm) A4 (210 × 297) K

B5JIS (182 × 257 mm) B5 (182 × 257) K

A5 (148 × 210 mm) A5 (148 × 210) K

A6 (105 × 148 mm) A6 (105 × 148) K

8 1/2 × 14 LG (8 1/2 × 14) K

8 1/2 × 11 LT (8 1/2 × 11) K

5 1/2 × 8 1/2 5 1/2 × 8 1/2 K

Custom(XXXxYYY mm) Custom Size

7 1/4 × 10 1/2 7 1/4 × 10 1/2 K

8 1/4 × 13 8 1/4 × 13 K

8 1/2 × 13 8 1/2 × 13 K

4 1/8 × 9 1/2 4 1/8 × 9 1/2 K

3 7/8 × 7 1/2 3 7/8 × 7 1/2 K

DL (110 × 220 mm) DL (110 × 220) K
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❖❖❖❖ *3 Input Tray: Status

❖❖❖❖ *4 Output Tray: Name

C5 Env (162 × 229 mm) C5 Env (162 × 229) K

8 × 13 8×13 K

C6 Env (114 × 162 mm) C6 Env (114 × 162) K

8K (267 × 390 mm) 8K (267 × 390) K

16K (195 × 267 mm) 16K (195 × 267) K

NCS There is no tray.

** The paper size is not selected.

Status Description

Normal 

NoTray There is no paper tray

PaperEnd There is no paper in the paper tray

Name Description

Standard Tray Output Tray

Paper Size Description
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❖❖❖❖ *5 Output Tray: Status

Status Description

Normal 

PaperExist There is paper in the output tray

OverFlow Output tray is full of paper

Error Other errors
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Understanding the Displayed Information 

This section describes how to read the status information returned by the Network Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.

• telnet : Use the status command. See p.195 “Printer status” .

Item name Meaning

Rank Print job status.

• Active
Printing or preparing for printing.

• Waiting
Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is “0 bytes”.
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Print Log Information

This is a record of the most recent 16 jobs that have been printed.

This log can be displayed with the following commands.

• telnet : Use the prnlog command. See p.195 “Printer status” .

*1 Appears the UserID and JobName information when entering the info command with the ID.

Name Meaning

ID Print request ID.

User Print request user name.

Page The number of pages that is printed.

Result The result of the print request.

Time The time when the print request was received

User ID *1 User ID that is to be configured in the printer driver.

JobName *1 The name of the document for printing.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed by using the commands below.

• telnet : Use the show command. See p.196 “Network Interface Board configuration settings infor-
mation” .

Item name Meaning

 Common 

 Mode 

 Protocol Up/Down 

 AppleTalk 

 TCP/IP 

 NetWare 

 NetBEUI 

IP over 1394 *1  *4 

SCSI print *4 

Ethernet interface

Syslog priority

NVRAM version 

 Device name 

 Comment 

 Location 

 Contact 

 Soft switch 

 

 

Up means active, Down means inactive.

 

 

 

 

 

 

 

Internal version number.
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 AppleTalk 

 Mode 

 Net 

 Object 

 Type 

 Zone 

 

AppleTalk protocol in selection.

Network number.

Macintosh printer name.

The type of printer.

Name of the zone that the printer belongs to.

 TCP/IP 

 Mode 

 ftp 

 lpr 

 rsh 

 diprint 

 web 

 telnet 

 snmp

 ipp

 EncapType 

 dhcp 

 Address 

 Netmask 

 Broadcast 

 Gateway 

Access Range[✩] *2 

 

Up means active, Down means inactive. 

 

 

 

 

 

 

 

 

Frame type.

Dynamic Host Configuration Protocol (on/off)

IP address.

Subnet mask.

Broadcast address.

Default gateway address.

Access Control Range.

Item name Meaning
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Primary WINS

Secondary WINS

Time server

Time Zone

Time server polling time

 Home page URL 

 Home page link name 

 Help page URL 

 SNMP protocol 

Primary WINS server address.

Secondary WINS server address.

NTP server address

NTP server time difference

Synchronizes interval

URL of homepage.

URL name of homepage.

URL of help page.

Protocol used with SNMP.

 NetWare 

 EncapType 

 RPRINTER number 

 Print server name 

 File server name

 Context name 

 Switch 

 Mode 

 NDS/Bindery 

 Packet negotiation 

 Print job timeout 

 

Frame type.

Remote printer number.

Print server name.

Name of the connect file server.

Context of print server.

 

Active mode.

(this value is fixed)

 

Time of the job timeout.

Item name Meaning
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 NetBEUI 

 Switch 

 Mode 

 Direct print 

 Notification 

 Workgroup name 

 Computer name 

 Comment 

 Share name[1] 

 

 

(this value is fixed)

(this value is fixed)

Notification of print job completion.

Name of the workgroup.

Name of the computer.

Comment.

Share name (name of the printer type).

IEEE 802.11b *3 

SSID SSID being used.

Channel range Channels available for use.

Channel Channel being used.

Communication mode IEEE 802.11b interface transmitting mode.

Rate IEEE 802.11b interface speed.

WEP encryption Whether WEP is enabled or disabled.

Auth Validity or invalidity of the authorized mode setting when using 
WEP.

Encryption key WEP key.

Item name Meaning
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*1 The optional 1394 Interface Unit supports TCP/IP only.
*2

✩ represents a target number between 1 and 5.
*3 You can display the item names when installing the optional the optional 802.11b Interface Unit.
*4 You can display the item names when installing the optional 1394 Interface Unit.

IP over 1394 *1  *4 

Device name

Address

Netmask

Broadcast

IP address.

Subnet mask.

Broadcast address.

SCSI print *4 

Bidi. Bidirectional setting (on/off).

 Shell mode Mode of the remote maintenance tool.

Item name Meaning
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Message List

This is a list of messages written in the printer's system log. The system log can be viewed using the
syslog command.

System Log Information

You can use the following methods to view the system log.

• telnet : Use the syslog command. See p.189 “Commands List” .

Message Description and Solutions

Access to NetWare server <file server name> denied. Ei-
ther there is no account for this print server on the Net-
Ware server or the password was incorrect. 

(In print server mode) Cannot log in to the file server. 
Make sure that the print server is registered on the file 
server. If a password is specified for the print server, de-
lete it.

add_sess: community<community name> already de-
fined.

The same community name already exists. Use another 
community name.

add_sess: session<community name>already defined. A requested community name is not defined.

add_sess: bad trap addr:<IpAddress>, community:<com-
munity name>

The IP address (0.0.0.0.) is unavailable when the commu-
nity access type is TRAP. Specify the host IP address for 
the TRAP destination.

add_sess_ipx: bad trap addr: <IPX address>, communi-
ty:<community name>

The IPX address (00:00:00:00:00:00) is unavailable 
when the community access type is TRAP. Specify the 
host IPX address for the TRAP destination.

add_sess_ipx: community <community name> already 
defined.

The same community name already exists. Use another 
community name.

add_sess_ipx: session_ipx<community name> not de-
fined.

A requested community name is not defined.
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ANONYMOUS FTP LOGIN FROM <IP address>, 
<password>

An anonymous login has been made with a password 
<password> from the host <IP address>.

anpd start. (AppleTalk) An anpd (AppleTalk Network Package Daemon) has 
started.

Attach FileServer =<file server name> Attached to the file server as a nearest server.

Attach to print queue <print queue name> (In print server mode) Attached to the print queue name.

Cannot create service connection (In remote printer mode) Cannot establish a connection 
with the file server. The number of file server users may 
exceed the maximum number that the file server can han-
dle.

Cannot find rprinter (<print server name>/<printer 
number>)

The printer having the number displayed on the print 
server does not exist. Make sure that the number of the 
printer is registered in the print server.

Change IP address from DHCP Server. The IP address changes when DHCP LEASE is renewed. 
To always assign the same IP address, set a static IP ad-
dress to the DHCP server.

child process exec error! (process name) Failed to start the network service. Turn the printer off 
and then on. If this does not work, contact your service or 
sales representatives.

Connected DHCP Server(<DHCP server address>). The IP address was successfully received from the DHCP 
server.

connection from <IP address> Logged on from the host <IP address>.

Message Description and Solutions
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Could not attach to FileServer<error number> (In remote printer mode) Cannot attach to the file server. 
For some reason, the file server refuses the connection. 
Check the file server configuration.

Could not attach to PServer<print server> (In remote printer mode) Cannot attach to the print server. 
For some reason, the print server refuses the connection. 
Check the print server configuration.

Current Interface Speed:xxxMbps The speed of the network (10 Mbps or 100 Mbps).

Current IP address <current IP address> The IP address <current IP address> was received from 
the DHCP server.

Current IPX address<IPX address> The current IPX address.

DHCP lease time expired. DHCP lease time has expired. The printer tries to discov-
er the DHCP server again. The IP address used up to now 
becomes invalid.

DHCP server not found. The DHCP server cannot be found. Make sure the DHCP 
server is running on the network.

dhcpcd start. A dhcpcd (DHCP client service) has started.

Duplicate IP=<IP address>(from <MAC address>). The same IP address is used. An IP address must be 
unique. Check the address of the device indicated in 
<MAC address>.

Established SPX Connection with PServer,

(RPSocket=<socket number>, connID=

<connection ID>)

(In remote printer mode) A connection with the print 
server has been established.

exiting lpd service has ended and the system is exiting the proc-
ess.

Message Description and Solutions
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Exit pserver (In print server mode) Exits the print server because the 
necessary print server settings have not been made.

Frametype =<frame type name> The <frame type name> is configured to be used on Net-
Ware.

httpd start. An httpd has started.

IEEE 802.11b Card Firmware REV.IEEE 802.11b Card 
Firmware REV.

This is the wireless LAN card's firmware version.

IEEE 802.11b current channel <Channel> The current channel is displayed.

The value chosen by the user is displayed in ad hoc mode.

The channel used in the access point is displayed in infra-
structure mode.

(Example: Current channel is 11.)

IEEE 802.11b current channel 11

IEEE 802.11b MAC Address = <MAC Address> The IEEE 802.11b I/F MAC address is displayed.

(Example: Current MAC address is 
00:00:74:XX:XX:XX.)

IEEE 802.11b MAC Address = 

00:00:74:XX:XX:XX

IEEE 802.11b SSID <ssid> (AP MAC Address < MAC 
Address>)

The SSID of the access point used in infrastructure mode 
and the MAC address of the access point are displayed.

(Example: Current MAC address is xx:xx:xx:xx:xx:xx 
and SSID value is "test-ssid".)

IEEE 802.11b SSID test-ssid (AP MAC Address 
xx:xx:xx:xx:xx:xx)

Message Description and Solutions
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IEEE 802.11b <transmission mode> mode This is the IEEE 802.11b transmission mode.

• IEEE 802.11b [Infrastructure] mode : in infrastructure 
mode

• IEEE 802.11b [802.11 Ad hoc] mode : in 802.11 adhoc 
mode

• IEEE 802.11b [Ad hoc] mode : in adhoc mode

IEEE 802.11b Tx Rate <Transfer Speed> The IEEE 802.11b transmitting speed (set speed) is dis-
played.

(Example: Current Tx Rate is 11Mbps.)

IEEE 802.11b Tx Rate 11Mbps

inetd start. An inetd has started.

<interface> started with IP: <IP address> <IP address> has been set for <Interface> and <Inter-
face> started.

<Interface>: Subnet overlap. Subnet from Netmask and the IP address you tried to set 
for <Interface> overlap the subnet for another interface.

Set Subnet so that it does not overlap with another inter-
face.

IPP cancel-job: permission denied. The printer could not authenticate the name of the user at-
tempting to cancel a job.

ipp disable. Printing with ipp is disabled.

ipp enable. Printing with ipp is enabled.

IPP job canceled. jobid=%d. The spooled job has been canceled due to an error or by 
user request.

Message Description and Solutions
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job canceled. jobid=%d. The spooled job has been canceled due to an error or by 
user request.

LeaseTime=<lease time>(sec), RenewTime=<renew 
time>(sec).

The resource lease time that was received from the DHCP 
server is <lease time> in seconds. The renewal time is 
also <renew time> in seconds.

Login to fileserver <file server name> 
(<IPX|IP>,<NDS|BINDERY|NDS|BINDERY>) 

(In print server mode) Logged in to the file server with 
NDS or BINDERY mode.

multid start. Data transmission service for multiprotocols has started.

nbstart start. (NetBEUI) The service for NetBEUI protocol stack setting has start-
ed.

NBT Registration Broadcast(<NetBIOS name>) Use a local broadcast to map <NetBIOS name> with the 
IP address.

nbtd start. A nbtd (NetBIOS over TCP/IP Daemon) has started. 
(Available only in DHCP mode)

NetBEUI Computer Name =<computer name> The NetBEUI Computer Name is defined as <computer 
name>.

nmsd start. (NetBEUI) A nmsd (Name Server Daemon) has started.

npriter start. (NetWare) (In remote printer mode) NetWare service has started.

nwstart start. (NetWare) The service for NetWare protocol stack setting has start-
ed.

Open log file <file name> (In print server mode) The specified log file has been 
opened.

papd start. (AppleTalk) AppleTalk print service has started.

Message Description and Solutions
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permission denied. Job cancellation was determined to be unauthorized after 
checking the user name and host address (except for 
ROOT authorization).

phy release file open failed. Replacing the Network Interface Board is required. Con-
tact your sales or service representatives.

Print queue <print queue name> cannot be serviced by 
printer 0, <print server name>

(In print server mode) The print queue name cannot be 
serviced. Make sure that print queue volume exists on the 
specified file server.

Print server <print server name> has no printer. (In print server mode) The printer object is not assigned 
to the print server <print server name>. Using NWadmin, 
assign the printer object, and then restart the printer de-
vice. 

Print session full Cannot accept the print session.

Printer <printer name> has no queue (In print server mode) The print queue is not assigned to 
the printer. Using NWadmin, assign the print queue to the 
printer, and then restart it.

pserver start. (NetWare) (In print server mode) NetWare service has started.

Required computer name (<Computer name>) is dupli-
cated name 

The same computer name is detected on the network. The 
start job determines the computer name by adding the 
computer name to the suffix (0,1....). Configure a new 
computer name that is unique.

Required file server (<file server name>) not found Cannot find the required file server.

restarted. LPD has started.
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sap enable, saptype=<SAP type>, sapname=<SAP 
name>

The SAP function has started. The SAP (SAP type and 
SAP name) packet is issued to advertise the service on the 
SAP table on the NetWare server.

Set context to <NDS context name> A <NDS context name> has been set. 

shutdown signal received. network service rebooting... Rebooting the network service.

smbd start. (NetBEUI) An smbd (SMB (Server Message Block) service) has 
started.

Snmp over ip is ready. Communication over TCP/IP with SNMP is available.

Snmp over IP over 1394 is ready. Communication over IP over 1394 with SNMP is availa-
ble.

Snmp over ipx is ready. Communication over IPX with SNMP is available.

snmpd start. SNMP service has started.

started. Direct print service has started.

The print server received error <error number> during at-
tempt to log in to the network.Access to the network was 
denied.Verify that the print server name and password are 
correct. 

Cannot log in to the file server. The print server is not reg-
istered or the password is specified. Register the print 
server without specifying a password.

win2kspd protocol-DOWN (APPEXIT). NVRAM setting ioctl (SPIO CAPPEXIT) of device 
SBP2TSP was set by protocol-DOWN.

SCSI print is not receiving data.

win2kspd protocol-UP (APPENTRY). NVRAM setting ioctl (SPIO CAPPENTRY) of device 
SBP2TSP was set by protocol-UP.

SCSI print is not receiving data.

win2kspd started. SCSI print (SBP-2) service has started.
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WINS name refresh :Server No Response There has been no response to the update request from the 
server. Confirm that the WINS server address is correct 
and the WINS server is working properly.

WINS name registration/refresh error code(errornumber) Set Net BIOS names those do not overlap with each other.

Confirm that the WINS server address is correct and the 
WINS server is working properly.

WINS name registration:Server No Response There has been no response to the registration request 
from the server. Confirm that the WINS server address is 
correct and the WINS server is working properly.

WINS server address0.0.0.0 The WINS server address has not been specified. Specify 
the WINS server address to match the printer name with 
WINS.

WINS Server=<WINS server address> NetBIOS 
Name=<NetBIOS name>

The printer name has been successfully registered in 
<WINS server address>.

WINS wrong scopeID The scope ID is wrong.

Specify the correct scope ID.

write error occurred. (diskfull) The hard disk became full while the spool file was being 
written.

Wait until enough HDD space becomes available as 
printing proceeds.

write error occurred. (fatal) A fatal error occurred while the spool file was being writ-
ten.

Turn the printer off and then on. If this does not work, 
contact your service or sales representative.

Message Description and Solutions
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Precautions

Please pay attention to the following when using the Network Interface Board. When configuration is
necessary, follow the appropriate procedures below.

Connecting a Dial Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router, packets are continu-
ously sent back and forth, possibly causing communication charges to increase. Because the packet
transmission is a specification of NetWare, you need to change the configuration of the router. If the
network you are using does not allow you to configure the router, configure the printer.

Configuring the router

Filter the packets so that they do not pass over the dial-up router.

Note

❒ The MAC address of the printer doing the filtering is printed on the printer configuration page. For

more information about printing a configuration page, see the Option Setup Guide that comes with

the printer.

❒ For more information about configuring the printer if the router cannot be configured, see the instruc-

tions below.
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Configuring the printer with NetWare

AAAA Follow the setup method in this manual, configure the file server.

BBBB Set the Frame type for a NetWare environment.

Reference

For more information about selecting a Frame type, see p.75 “Configuring the NetWare Protocol

using the Control Panel”.

Configuring the printer without NetWare

AAAA While not printing, the Network Interface Board sends packets on the network. Set the Net-

Ware to inactive.

Reference

For more information about selecting a protocol, see p.75 “Configuring the NetWare Protocol us-

ing the Control Panel”.
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PostScript Printing from Windows

When printing PostScript from Windows, see the PostScript 3 Supplement.

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled by the printer driver
on Windows. If the NetWare form feed is configured, the printer might not print properly. If you want
to change the form feed setting, always configure it on Windows.

• With Windows 95/98/Me, clear the [Form Feed] check box under the [Printer Settings] tab in the
Printer Properties dialog box.

• With Windows 2000, clear the [Form Feed] check box under the [NetWare Settings] tab in the Printer
Properties dialog box.

• With Windows NT 4.0, clear the [Form Feed] check box under the [NetWare Settings] tab in the
Printer Properties dialog box.
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Banner Page

You should not configure a banner page on NetWare. If you want to change the banner page setting,
always configure it on Windows. 

• With Windows 95/98/Me, clear the [Enable banner] check box under the [Printer Settings] tab in the
Printer Properties dialog box.

• With Windows 2000, clear the [Enable banner] check box under the [NetWare Settings] tab in the
Printer Properties dialog box.

• With Windows NT 4.0, clear the [Enable banner] check box under the [NetWare Settings] tab in the
Printer Properties dialog box.

Printing after resetting the printer

After resetting the remote printer, it will be cut off from the print server for about 30-40 seconds before
connecting again. Due to the NetWare specification, print jobs may be accepted, but they will not be
printed during this interval.

When using the printer as a remote printer, wait about 2 minutes after resetting the printer before at-
tempting to print. 
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Using DHCP

You can use the printer under a DHCP environment. You can also register the printer NetBIOS name
on a WINS server when it is running.

Limitation

❒ DHCP cannot be used with IEEE 1394 (IP over 1394). Set a fixed IP address with the control panel,

telnet or a Web browser.

• See Option Setup Guide.

• See p.189 “TCP/IP address”.

• See p.111 “Configuring the Network Interface Board Settings”.

Note

❒ Printers that register the printer NetBIOS name on a WINS server must be configured for the WINS

server. See p.208 “WINS”.

❒ Supported DHCP server is Windows NT 4.0 Server Service Pack 4 or later, Windows 2000 Server

and NetWare 5.

❒ If you do not use the WINS server, reserve the printer's IP address in the DHCP server so that the

same IP address is assigned every time.

❒ DHCP relay-agent is not supported. If you use DHCP relay-agent on a network via an ISDN line, it

will result in expensive line charges. This is because your computer connects to the ISDN line when-

ever a packet is transferred from the printer.
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Using AutoNet

If the printer IP address is not assigned by a DHCP server automatically, a temporary IP address starting
with 169.254 which is not used on the network can be selected automatically by the printer.

Limitation

❒ You must change the setting to "on" to use AutoNet. See p.209 “AutoNet”.

Note

❒ The IP address assigned by the DHCP server is given priority to that selected by AutoNet.

❒ You can confirm the current IP address on the configuration page. For more information about the

configuration page, see p.134 “Printing a Configuration Page”.

❒ When AutoNet is running, the NetBIOS name is not registered on the WINS server.
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Configuring a WINS Server

The printer can be configured to register its NetBIOS name with a WINS server when power is turned
on. This enables the NetBIOS name of the printer to be specified from SmartDeviceMonitor for Admin
even under a DHCP environment.

This section describes how to configure the WINS server.

Note

❒ The WINS Server is supported with Windows NT 4.0 Server Service Pack 4 or later, and Windows

2000 Servers WINS Manager.

❒ For more information about the WINS Server settings, see Windows Help.

❒ If there is no reply from the WINS Server, the NetBIOS name will be registered by broadcast.

❒ The NetBIOS name consists of up to 13 alphanumeric characters.

Using a Web browser

AAAA Start the Web browser.

BBBB Point your browser at the URL or IP address of the printer (e.g. http://XXX.XXX.XXX sub-

stituting the Xs with the IP address).

The status of the printer you chose appears on the Web browser.

CCCC Click [Network Config].

The dialog box for entering the password and user name is displayed.

DDDD Enter your user name and password, and then click [OK].

To use the factory default account, enter no user name and type "password" for the password.
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EEEE Click [TCP/IP].

FFFF Set WINS to active and enter the IP address of the WINS server in Primary WINS Server and

Secondary WINS Server.

GGGG Click [Refresh].

HHHH Exit the Web browser.

Using telnet

AAAA Connect to the remote printer using telnet.

BBBB Use the set command to make WINS active.

msh> set wins on

CCCC Specify the IP addresses (primary and secondary) using the following commands.

msh> wins primary Ipaddress
msh> wins secondary Ipaddress

Note

❒ To confirm the current configuration, use the show command.

DDDD Log out from telnet.
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Memory Capacity and Paper Size

❖❖❖❖ Standard 128 MB, up to 384 MB (two SDRAM Module slots model)

Print Quality Paper Size
Non-Duplex Printing Duplex Printing

Can be printed Guaranteed Can be printed Guaranteed

600×600 dpi *1 

A4

128 MB (Standard) 128 MB (Standard)
B5

LT

Legal

1200×600 dpi *2 

A4

128 MB (Standard) 128 MB (Standard)
B5

LT

Legal

1200×1200 dpi *3 

A4

128 MB (Standard)
128 MB 

(Standard)

192 MB
 (Std. + 64 MB)

B5 128 MB (Std.)

LT 192 MB
 (Std. + 64 MB)Legal
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❖❖❖❖ Standard 64 MB, up to 256 MB (one SDRAM Module slot model)

*1 To set resolution from each printer driver is as follows:
• RPCS: [600 x 600 dpi] on [Resolution]
• PCL 5c: [600 dpi] on [Resolution]
• PostScript 3: [600 dpi] on [Resolution] and [Fast] on [Gradation]

Reference

For more information about how to set the printer driver, see printer driver's Help.

Print Quality Paper Size
Non-Duplex Printing Duplex Printing

Can be printed Guaranteed Can be printed Guaranteed

600×600 dpi *1 

A4

64 MB (Standard) 64 MB (Standard)
B5

LT

Legal

1200×600 dpi *2 

A4

64 MB (Standard)
64 MB

(Standard)
128 MB
(Option)

B5

LT

Legal

1200×1200 dpi *3 

A4

64 MB
(Standard)

128 MB
(Option)

64 MB
(Standard)

256 MB (Option)

B5 128 MB (Option)

LT
256 MB (Option)

Legal
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*2 To set resolution from each printer driver is as follows:
• RPCS: [1200 x 600 dpi] on [Resolution]
• PostScript 3: [600 dpi] on [Resolution] and [Standard] on [Gradation]

Reference

For more information about how to set the printer driver, see printer driver's Help.
*3 To set resolution from each printer driver is as follows:

• RPCS: [1200 x 1200 dpi] on [Resolution]

• PostScript 3: [1200dpi] on [Resolution] and [Standard] on [Gradation]

Reference

For more information about how to set the printer driver, see printer driver's Help.
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Specifications

Mainframe

❖❖❖❖ Configuration:
Desktop

❖❖❖❖ Print Process:
Laser beam scanning & Electrophotographic printing
Mono component toner development
4 drums tandem method

❖❖❖❖ Printing Speed:

• Color
A4K: 16/17 pages per minute
81/2×11K: 16.9/18 pages per minute

• Monochrome
A4K: 16/21 pages per minute
81/2×11K: 16.9/22 pages per minute

• First print speed: 15.5 seconds (default-Pre Heat On) / 25 seconds or less (Pre Heat Off)
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❖❖❖❖ Interface:

• Network standard model
Standard:

• Parallel (Bidirectional IEEE1284)

• Ethernet (10/100Base-TX)

• USB (USB1.1, USB2.0 *1 )
*1 It requires a USB computer port and cable that support USB 2.0.

Optional:

• IEEE 1394 (SCSI print, IP over 1394)

• IEEE 802.11b (Wireless LAN)

• BluetoothTM

• Basic model
Standard:

• Parallel (Bidirectional IEEE1284)

• USB (USB1.1, USB2.0 *1 )
*1 It requires a USB computer port and cable that support

Optional:

• Ethernet (10/100Base-TX)

• IEEE 1394 (SCSI print, IP over 1394)

• IEEE 802.11b (Wireless LAN)

• BluetoothTM
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❖❖❖❖ Resolution:
1200 × 1200 dpi (RPCS, PostScript 3)
1200 × 600 dpi (RPCS, PostScript 3)
600 × 600 dpi (PCL 5c, RPCS, PostScript 3)
300 × 300 dpi (PCL 5c *1 , RPCS)
*1 monochrome only

❖❖❖❖ Printer Language:
PCL 5c, RPCS, Adobe PostScript Level 3

❖❖❖❖ Fonts:
PCL 5c

Agfa Font 35 Manager Intellifonts, 10 TrueType fonts, and 1 Bitmap font Agfa
Font Manager available, 31 fonts
PostScript 3

136 fonts

❖❖❖❖ Paper size:
See “Paper and Other Media”, Maintenance Guide.

❖❖❖❖ Paper Weight:
See “Paper and Other Media”, Maintenance Guide.

❖❖❖❖ Media Type:
See “Paper and Other Media”, Maintenance Guide.

❖❖❖❖ Power Source:
120 V, 60 Hz
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❖❖❖❖ Power Consumption:

❖❖❖❖ Noise Emission *1 :
Sound Power Level

Sound Pressure level *2 

*1 The preceding measurements made in accordance with ISO7779 are actual values.
*2 Measured at the position of a bystander.

❖❖❖❖ Dimensions:

❖❖❖❖ Weight:
Approximately 30.5 kg (67.2 lb) (toner cartridge and power cord included)

Printing 1300 W or less

Energy Saver 9 W or less

Mainframe only

During Printing 65 dB (A)

Stand-by 40 dB (A) 

Mainframe only

Stand by 34 dB (A)

During Printing 52 dB (A)

Width Depth Height

Printer only (tray not ex-
tended)

570 mm (22.4 inches) 649 mm (25.6 inches) 635 mm (25.0 inches)
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❖❖❖❖ Warm-up Time:
Less than 30 seconds (23°C, 73F) *1 

*1 When no error.

❖❖❖❖ Paper Input Capacity:

*1 Paper weight: 80 g/m2 (20 lb. bond)
*2 You can load up to 10 envelopes at the same time.

❖❖❖❖ Paper Output Capacity:
Standard 250 sheets (80 g/m2 (20 lb.bond))

❖❖❖❖ Memory:
Standard 64/128 MB, up to 256/384 MB (with the optional Memory Unit)
SDRAM capacity varies depending on model. 

❖❖❖❖ Network:
Protocol: TCP/IP, NetBEUI *1 , IPX/SPX, AppleTalk
*1 To use NetBEUI, use the SmartDeviceMoniter for Client port.

Standard Paper Tray 530 sheet tray *1 

Bypass Tray 100 sheet *2 

Optional Paper Feed Units 530 sheet paper tray × 2 *1 
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Options

PAPER FEED UNIT Type 3000

❖❖❖❖ Dimensions (W ×××× D ×××× H):
508 × 639 × 286 mm (20.0 × 25.2 × 11.3 inches)

❖❖❖❖ Paper size:
A4, B5(JIS), 8 1/2 × 14, 81/2 × 11

❖❖❖❖ Paper weight:
60 - 105 g/m2, (16 - 28 lb. bond)

❖❖❖❖ Weight:
Less than 7.5 kg (16.4 lb)

AD440

❖❖❖❖ Dimensions (W ×××× D ×××× H):
400 × 303 × 138 mm (15.7 × 11.9 × 5.4 inches)

Note

❒ This option is built into the machine.

❖❖❖❖ Paper size:
A4, B5(JIS), 8 1/2 × 14, 81/2 × 11



Operating Instructions Administrator Reference

253

❖❖❖❖ Paper weight:
60 - 105 g/m2 (16 - 28 lb. bond)

❖❖❖❖ Weight:
Less than 0.8 kg (1.7 lb. bond)

Printer Hard Disk Type 3000

❖❖❖❖ Storage Capacity (Formatted):
10 GB

❖❖❖❖ Specifications:

• Spool print data to collate

• Spool Sample/Locked Print data

• Store PostScript fonts

• Store log data

Note

❒ You can install PostScript fonts with this optional Printer Hard Disk Type 3000. With Macintosh,

types of fonts supported are PostScript Type 1 and PostScript Type 2. To download them, use

Printer Utility for Mac.

Memory Unit Type C 64/128/256MB

❖❖❖❖ Module Type:
SO-DIMM (Small Outline Dual-in-line Memory Module)
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❖❖❖❖ Memory Type:
SDRAM (Synchronous Dynamic RAM)

❖❖❖❖ Number of Pins:
144 pins

User Account Enhance Unit Type B

❖❖❖❖ Capacity:
64 KB

❖❖❖❖ Specifications:
Store User Code (Up to 400 users)

Network Interface Board Type 3000

❖❖❖❖ Topology:
Ethernet (10Base-T/100Base-TX)

❖❖❖❖ Protocols:
TCP/IP, NetBEUI, IPX/SPX, AppleTalk

❖❖❖❖ Interface Connector:
RJ45

❖❖❖❖ Required Cable:
STP (Shielded Twisted-Pair) cable
Category / Type 5 or better
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1394 Interface Unit Type 4510

❖❖❖❖ Interface:
IEEE Std. 1394-1955 compliant, IEEE Std. 1394-2000 compliant.

❖❖❖❖ Interface Connector:
IEEE 1394 (6 pins × 2)

❖❖❖❖ Required cable:
IEEE 1394 interface cable (6 pins x 4 pins, 6 pins x 6 pins)

Important

❒ You cannot plug devices together to create loops.

❒ Do not use a cable more than 4.5 meters long.

❖❖❖❖ Connectable number of devices in a bus:
Maximum 63

❖❖❖❖ Allowed cable hops in a bus:
Maximum 16

❖❖❖❖ Data Transmission:
400 Mbps (Maximum)

❖❖❖❖ Power supply:
Non power supply
Cable Power repeated (IEEE 1394a-2000 compliant)
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802.11b Interface Unit TypeA (R-WL11)

❖❖❖❖ Transmission Spec.:
Based on IEEE 802.11b (Wireless LAN)

❖❖❖❖ Protocol:
TCP/IP, NetBEUI, IPX/SPX, AppleTalk

Note

❒ SmartDeviceMonitor and Web Status Monitor are supported.

❖❖❖❖ Data Transfer Speed:
Auto select from below speed
1Mbps, 2Mbps, 5.5Mbps, 11Mbps

❖❖❖❖ Frequency Range:

• Inch version:
2412-2462 Mhz (1-11 channels)

• Metric version:
2412-2472 Mhz (1-13 channels)

❖❖❖❖ Transmittable Distance:
1Mbps 400m *1 

2Mbps 270m *1 

5.5Mbps 200m *1 

11Mbps 140m *1 

*1 These figures are a guideline for outdoor use. In general, the transmittable distance indoors is 10-100
m, depending on the environment.

❖❖❖❖ Transmission Mode:
ad hoc mode and infrastructure mode
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Information about Installed Software

expat

Use of the software installed on this product, including the controller (hereinafter "software") and the ex-
pat Version 1.95.2 application software (hereinafter "expat 1.95.2"), is subject to the following conditions:

The product manufacturer provides warranty and support to the software of the product including expat
1.95.2 and the product manufacturer allows the initial developer of expat 1.95.2 to be free from these
obligations.

Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

and Clark Cooper

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without limita-
tion the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Soft-
ware, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial por-
tions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IM-
PLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS
OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Note

❒ Information on expat 1.95.2 is available at:

http://expat.sourceforge.net/



Operating Instructions Administrator Reference

258

JPEG LIBRARY

• The software installed on this product is based in part on the work of the Independent JPEG Group.

NetBSD

Copyright Notice of NetBSD

For all users to use this product:

This product contains NetBSD operating system:

For the most part, the software constituting the NetBSD operating system is not in the public domain;
its authors retain their copyright.

The following text shows the copyright notice used for many of the NetBSD source code. For exact
copyright notice applicable for each of the files/binaries, the source code tree must be consulted.

A full source code can be found at http://www.netbsd.org/.

Copyright © 1999, 2000 The NetBSD Foundation, Inc.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

A Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

B Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

C All advertising materials mentioning features or use of this software must display the following ac-
knowledgment:
This product includes software developed by the NetBSD Foundation, Inc. and its contributors.
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D Neither the name of The NetBSD Foundation nor the names of its contributors may be used to en-
dorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE NETBSD FOUNDATION, INC. AND CONTRIBU-
TORS ''AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIM-
ITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EX-
EMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PRO-
CUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILI-
TY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Authors Name List

All product names mentioned herein are trademarks of their respective owners.

The following notices are required to satisfy the license terms of the software that we have mentioned
in this document:

• This product includes software developed by the University of California, Berkeley and its contrib-
utors.

• This product includes software developed by Jonathan R. Stone for the NetBSD Project.

• This product includes software developed by the NetBSD Foundation, Inc. and its contributors.

• This product includes software developed by Manuel Bouyer.

• This product includes software developed by Charles Hannum.

• This product includes software developed by Charles M. Hannum.

• This product includes software developed by Christopher G. Demetriou.
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• This product includes software developed by TooLs GmbH.

• This product includes software developed by Terrence R. Lambert.

• This product includes software developed by Adam Glass and Charles Hannum.

• This product includes software developed by Theo de Raadt.

• This product includes software developed by Jonathan Stone and Jason R. Thorpe for the NetBSD
Project.

• This product includes software developed by the University of California, Lawrence Berkeley Lab-
oratory and its contributors.

• This product includes software developed by Christos Zoulas.

• This product includes software developed by Christopher G. Demetriou for the NetBSD Project.

• This product includes software developed by Paul Kranenburg.

• This product includes software developed by Adam Glass.

• This product includes software developed by Jonathan Stone.

• This product includes software developed by Jonathan Stone for the NetBSD Project.

• This product includes software developed by Winning Strategies, Inc.

• This product includes software developed by Frank van der Linden for the NetBSD Project.

• This product includes software developed for the NetBSD Project by Frank van der Linden

• This product includes software developed for the NetBSD Project by Jason R. Thorpe.

• The software was developed by the University of California, Berkeley.

• This product includes software developed by Chris Provenzano, the University of California, Ber-
keley, and contributors.
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INDEX

1394 Interface Unit Type 4510,   255

4C.Graphic Mode,   140

A

Access Control,   192

Append CR to LF,   175

Auto Continue,   153

Autonet,   241

telnet,   209

B

Bidirectional transmission,   32, 51, 72

B&W Page Detect,   153

Bypass Size,   126

C

Cable,   255

Changing Names and Comments
SmartDeviceMonitor for Admin,   100

Web Browser,   115

Color Demo Page,   133

Color Regist.,   140

Community Name,   197

Config. Page,   133, 134

Configuration
NetWare,   75

NetWare 3.x,   80

NetWare 4.x, 5/5.1, 6,   87

Windows 2000,   14

Windows NT 4.0,   54

Windows Server 2003,   35

Windows XP,   35

Configuring NetBEUI for Printing
Windows 2000,   17

Windows NT 4.0,   57

Configuring the Protocols
Windows 2000,   14

Windows NT 4.0,   54

Windows Server 2003,   35

Windows XP,   35

Copies,   153

D

DHCP,   193, 240

Dial Up Router,   236

Displaying Printer Status
SmartDeviceMonitor for Admin,   102

Web Browser,   118

Duplex,   153
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E

Energy Saver 1,   153

Envelope Type,   140

E.Saver2 OnOff,   153

E. Saver2 Timer,   153

Escape key,   125

Ext. A4 Width,   175

F

Font Number,   175

Font Pitch,   175

Fonts,   249

Font Source,   175

Form Lines,   175

G

Getting Printer Information over the Network,   213

H

HDD Format,   140

Hex Dump,   133

Host Interface,   124, 163, 164

Host Name,   209

I

IEEE 1394 Setup,   163

IEEE 802.11b,   163, 205

Image Density,   140

Information
Network Interface Board

 configuration,   196, 222

print job,   220

print log,   221

system log,   196, 227

Installing
SmartDeviceMonitor for Admin,   98

SmartDeviceMonitor for Client,   18, 38, 59

Installing Software
Windows 2000,   18

Windows NT 4.0,   59

Windows Server 2003,   38

Windows XP,   38

I/O Buffer,   163

I/O Timeout,   163

IP address,   189

IPP,   200

IPP for Printing
Windows 2000,   14

Windows NT 4.0,   54

Windows Server 2003,   35

Windows XP,   35
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K

Key Repeat,   140

L

LAN adapter number (Lana Number),   58

Language,   124, 181

Letterhead Mode,   153

List/Test Print,   124, 133

List/Test Print Parameters,   133

Locked Print,   124

M

Maintenance,   124, 140, 141

Maint. Reset,   140

Making Printer Settings with the Control Panel,   119

Memory,   251

Memory Capacity and Paper Size,   244

Memory Overflow,   153

Memory Unit Type C 64/128/256MB,   253

Menu, accessing,   124

Menu, changing,   181

Menu Chart,   119

Menu key,   124

Menu List,   133

Menu Protect,   140

Message,   227

MIB,   184

MisfeedRecovery,   153

N

NetWare,   75

NetWare 3.x,   80

NetWare 4.x, 5/5.1, 6,   87

NetWare Printing,   238

Network Interface Board,   251

Network Interface Board Type 3000,   254

Network Setup,   163

NIB,   251

O

On Line key,   125

Options,   252

Orientation,   175

P

Page Size,   153

Paper Input,   124, 126

Paper Type,   126

Password,   110, 212

PCL,   175

PCL Config.Page,   133

PCL Menu,   124

PlainPaper Type,   140

Point Size,   175

PostScript Printing from Windows,   238

Precautions,   236

Print Area,   140
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Printer Hard Disk Type 3000,   253

Printer Lang.,   153

Printer Status,   195

Prt. Err Report,   153

PS Config. Page,   133

Pure IP,   90

R

Registration,   140

Remote printer, setup
NetWare 4.x, 5,   92

Resolution,   153

ROM Update,   140

S

Sample Print,   124

SDRAM,   251

Series Prnt.Job,   140

Setting Up as a Print Server
NetWare3.x,   81

NetWare4.x/NetWare5.1,   88

Setting Up as a Remote Printer
NetWare3.x,   83

NetWare4.x/NetWare5.1,   92

Setting Up Options
Windows 2000,   30

Windows NT 4.0,   70

Windows Server 2003,   49

Windows XP,   49

Share Setting
Windows 2000,   34

Windows NT 4.0,   74

Windows Server 2003,   53

Windows XP,   53

SmartDeviceMonitor for Admin
Installing,   98

SmartDeviceMonitor for Client
Installing,   18, 59, 38

SMB,   203

SNMP,   184, 197

SNTP,   210

Specifications,   247

Spool Printing,   153

Subnet Mask,   191

Sub Paper Size,   153

Symbol Set,   175

System,   124, 153

T

TCP/IP for Printing
Windows 2000,   14

Windows NT 4.0,   54

Windows Server 2003,   35

Windows XP,   35

telnet,   187

Autonet,   209

WINS,   208

Tray Locking,   126

Tray Priority,   126
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U

Unit of Measure,   153

USB Setting,   163

User Account Enhance Unit Type B,   254

Using a Web Browser,   108

Using SmartDeviceMonitor for Admin,   96

W

Windows 2000,   14

Share Setting,   34

Windows NT 4.0,   54

Share Setting,   74

Windows Server 2003,   35

Share Setting,   53

Windows XP,   35

Share Setting,   53

WINS,   242

telnet,   208

WL.LAN Defaults,   140

WL.LAN Signal,   140
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